Preface

Notice
The company reserves the right to revise this publication or to change its contents without notice. Information contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse) of this publication.

This publication and any accompanying software may not, in whole or in part, be reproduced, translated, transmitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators of this publication, except for copies kept by the user for backup purposes.

Brand and product names mentioned in this publication may or may not be copyrights and/or registered trademarks of their respective companies. They are mentioned for identification purposes only and are not intended as an endorsement of that product or its manufacturer.

©May 2008

Trademarks
This product incorporates copyright protection technology that is protected by method claims of certain U.S. patents and other intellectual property rights owned by Macrovision Corporation and other rights owners. Use of this copyright protection technology must be authorized by Macrovision Corporation, and is intended for home or other limited viewing uses only unless otherwise authorized by Macrovision Corporation. Reverse engineering or disassembly is prohibited.

Intel and Intel Core are trademarks/registered trademarks of Intel Corporation.
SRS is a trademark of SRS Labs, Inc.
WOW technology is incorporated under license from SRS Labs, Inc.
Preface

FCC Statement
(Federal Communications Commission)
You are cautioned that changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Re orient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.
   And
2. This device must accept any interference, including interference that may cause undesired operation of the device.
FCC RF Radiation Exposure Statement:

1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator and your body.

⚠️ Warning

Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not expressly approved by the manufacturer for compliance with the above standards could void your authority to operate the equipment.
IMPORTANT SAFETY INSTRUCTIONS

Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet basement or near a swimming pool.
2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There may be a remote risk of electrical shock from lightning.
3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit (Full Range AC/DC Adapter - AC Input 100 - 240V, 50 - 60Hz/ DC Output 20V, 6.A (120W) minimum).

CAUTION

Always disconnect all telephone lines from the wall outlet before servicing or disassembling this equipment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO. 26 AWG OR LARGER, TELE-COMMUNICATION LINE CORD

This Computer’s Optical Device is a Laser Class 1 Product
Instructions for Care and Operation

The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. **Don’t drop it, or expose it to shock.** If the computer falls, the case and the components could be damaged.

   ![Diagram](image1)
   - Do not expose the computer to any shock or vibration.
   - Do not place it on an unstable surface.
   - Do not place anything heavy on the computer.

2. **Keep it dry, and don’t overheat it.** Keep the computer and power supply away from any kind of heating element. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly damaged.

   ![Diagram](image2)
   - Do not expose it to excessive heat or direct sunlight.
   - Do not leave it in a place where foreign matter or moisture may affect the system.
   - Don’t use or store the computer in a humid environment.
   - Do not place the computer on any surface that will block the Vents/Fan Intakes.
3. **Avoid interference.** Keep the computer away from high capacity transformers, electric motors, and other strong magnetic fields. These can hinder proper performance and damage your data.

4. **Follow the proper working procedures for the computer.** Shut the computer down properly and don’t forget to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

<table>
<thead>
<tr>
<th>Do not turn off the power until you properly shut down all programs.</th>
<th>Do not turn off any peripheral devices when the computer is on.</th>
<th>Do not disassemble the computer by yourself.</th>
<th>Perform routine maintenance on your computer.</th>
</tr>
</thead>
</table>

5. **Take care when using peripheral devices.**

| Use only approved brands of peripherals. | Unplug the power cord before attaching peripheral devices. |
Power Safety

The computer has specific power requirements:

- Only use a power adapter approved for use with this computer.
- Your AC/DC adapter may be designed for international travel but it still requires a steady, uninterrupted power supply. If you are unsure of your local power specifications, consult your service representative or local power company.
- The power adapter may have either a 2-prong or a 3-prong grounded plug. The third prong is an important safety feature; do not defeat its purpose. If you do not have access to a compatible outlet, have a qualified electrician install one.
- When you want to unplug the power cord, be sure to disconnect it by the plug head, not by its wire.
- Make sure the socket and any extension cord(s) you use can support the total current load of all the connected devices.
- Before cleaning the computer, make sure it is disconnected from any external power supplies (i.e. AC/DC adapter or car adapter).

Do not plug in the power cord if you are wet.

Do not use the power cord if it is broken.

Do not place heavy objects on the power cord.
Preface

Battery Precautions

- Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
- Do not remove any batteries from the computer while it is powered on.
- Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire.
- Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
- Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qualified service personnel.
- Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries may explode or leak if exposed to fire, or improperly handled or discarded.
- Keep the battery away from metal appliances.
- Affix tape to the battery contacts before disposing of the battery.
- Do not touch the battery contacts with your hands or metal objects.

Battery Disposal & Caution

The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life, under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the manufacturer. Discard used battery according to the manufacturer’s instructions.
Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the power supply. Then refer servicing to qualified service personnel under any of the following conditions:

- When the power cord or AC/DC adapter is damaged or frayed.
- If the computer has been exposed to rain or other liquids.
- If the computer does not work normally when you follow the operating instructions.
- If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
- If there is an unusual odor, heat or smoke coming from your computer.

Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and screw(s) before turning the computer on.
Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it’s latched.
4. Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.
5. The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However, check with your travel agent to see if you need any socket adapters.
6. Put the notebook in its carrying bag and secure it with the bag’s straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hardware and software. Make sure your “papers” are handy.

Power Off Before Traveling
Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a notebook which is powered on in a travel bag may cause the Vents/Fan Intakes to be blocked. To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intakes while the computer is in use.
On the Road
In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting, keep these points in mind:

**Hand-carry the notebook** - For security, don’t let it out of your sight. In some areas, computer theft is very common. Don’t check it with “normal” luggage. Baggage handlers may not be sufficiently careful. Avoid knocking the computer against hard objects.

**Beware of Electromagnetic fields** - Devices such as metal detectors & X-ray machines can damage the computer, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). **Note:** Some airports also scan luggage with these devices.

**Fly safely** - Most airlines have regulations about the use of computers and other electronic devices in flight. These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

**Get power where you can** - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies) charged.

**Keep it dry** - If you move quickly from a cold to a warm location, water vapor can condense inside the computer. Wait a few minutes before turning it on so that any moisture can evaporate.
Preface

Developing Good Work Habits
Developing good work habits is important if you need to work in front of the computer for long periods of time. Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or other joints. The following are some tips to reduce the strain:

- Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.
- Your knees should be slightly higher than your hips. Place your feet flat on the floor or on a footrest if necessary.
- Use a chair with a back and adjust it to support your lower back comfortably.
- Sit straight so that your knees, hips and elbows form approximately 90-degree angles when you are working.

- Take periodic breaks if you are using the computer for long periods of time.

Remember to:
- Alter your posture frequently.
- Stretch and exercise your body several times a day.
- Take periodic breaks when you work at the computer for long periods of time. Frequent and short breaks are better than fewer and longer breaks.
Lighting
Proper lighting and a comfortable viewing angle can reduce eye strain and shoulder and neck muscle fatigue.

- Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
- Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
- Position the display directly in front of you at a comfortable viewing distance.
- Adjust the display-viewing angle to find the best position.

LCD Screen Care
To prevent image persistence on LCD monitors (caused by the continuous display of graphics on the screen for an extended period of time) take the following precautions:

- Set the Windows Power Plans to turn the screen off after a few minutes of screen idle time.
- Use a rotating, moving or blank screen saver (this prevents an image from being displayed too long).
- Rotate desktop background images every few days.
- Turn the monitor off when the system is not in use.

Cable TV Safety
If you have included a TV Tuner in your purchase option then pay careful attention to the following:

- Make sure that your CATV system installer has connected the Coaxial cable shield to the grounding system of the building, as close to the point of cable entry as practical.
- This reminder is provided to call the CATV system installer’s attention to Article 820-93 of the NEC (Section 54, Part I of the Canadian Electrical Code).
- The TV antenna supplied with any TV Tuner module is intended for indoor use only. Please do not use your TV Tuner module outdoors.
Preface
Preface

Contents

Notice .................................................................................I
FCC Statement .............................................................II
FCC RF Radiation Exposure Statement: .................... III
Instructions for Care and Operation ....................... V
Power Safety .............................................................VII
Battery Precautions ................................................. VIII
Cleaning .....................................................................IX
Servicing .................................................................... IX
Travel Considerations ................................................. X

Quick Start Guide

Overview .................................................................1-1
Advanced Users .......................................................1-2
Beginners and Not-So-Advanced Users ...............1-2
Warning Boxes .........................................................1-2
Not Included ............................................................1-2
Model Differences ...................................................1-3
System Software .......................................................1-4
System Startup ..........................................................1-5
System Map: LCD Panel Open ..............................1-6
LED Indicators ..........................................................1-7
Hot Key Buttons & Keyboard ...............................1-8
Function/Hot Key Indicators ...............................1-9

System Map: Front & Rear Views ..............................1-10
System Map: Right View .........................................1-11
System Map: Left View ............................................1-12
System Map: Bottom View .....................................1-13
Windows Vista Start Menu & Control Panel ..........1-14
Video Features ..........................................................1-15
Display Devices & Options ...................................1-16
Power Options ............................................................1-17

Storage Devices, Mouse, Audio & Printer

Overview .................................................................2-1
Hard Disk Drive ........................................................2-2
Optical Device ............................................................2-3
Loading Discs .............................................................2-3
Handling CDs or DVDs ............................................2-4
DVD Regional Codes ...............................................2-5
7-in-1 Card Reader ....................................................2-6
ExpressCard Slot ......................................................2-7
TouchPad and Buttons/Mouse ..............................2-8
Audio Features ..........................................................2-9
Setup for Audio Recording ....................................2-10
Adding a Printer ..........................................................2-11
Preface

USB Printer ...............................................................2-11
Install Instructions: ...................................................2-11
Parallel Printer ...........................................................2-11

Power Management
Overview .................................................................3-1
The Power Sources .......................................................3-2
AC/DC Adapter ..........................................................................................3-2
Battery ..........................................................................................3-2
Turning on the Computer .........................................................3-3
Power Plans ..................................................................................3-4
Power-Saving States .................................................................3-6
Sleep ..........................................................................................3-6
Hibernate ..................................................................................3-7
Shut Down ..................................................................................3-7
Configuring the Power Buttons ...................................................3-8
Resuming Operation .................................................................3-9
Battery Information .................................................................3-10
Battery Power ..............................................................................3-10
Conserving Battery Power .......................................................3-11
Battery Life ..................................................................................3-12
New Battery ..................................................................................3-12
Recharging the Battery with the AC/DC Adapter ........3-12
Proper handling of the Battery Pack .................................3-13
Battery FAQ ..................................................................................3-14

Drivers & Utilities
What to Install .................................................................................4-1
Module Driver Installation ...........................................................4-1
Driver Installation ........................................................................4-2
Updating/Reinstalling Individual Drivers .................................4-4
User Account Control (Win Vista) .................................................4-4
Windows Security Message ......................................................4-4
New Hardware Found .................................................................4-4
Driver Installation Procedure ...................................................4-5
Chipset ..........................................................................................4-5
Video ............................................................................................4-5
Audio Drivers ..............................................................................4-5
Audio ............................................................................................4-5
Modem ..........................................................................................4-6
LAN ............................................................................................4-6
Card Reader/ExpressCard .........................................................4-6
TouchPad ......................................................................................4-6
Hot Key .........................................................................................4-6
Optional Drivers .........................................................................4-7
PC Camera Module .....................................................................4-7
Wireless LAN Module .................................................................4-7
Fingerprint Reader Module .........................................................4-8
TV Tuner Module .........................................................................4-8
# BIOS Utilities

**Overview** ................................................................. 5-1
**The Power-On Self Test (POST)** ................................... 5-2
  - Failing the POST ............................................... 5-3
  - Fatal Errors ...................................................... 5-3
  - Non-Fatal Errors ................................................ 5-3
**The Setup Utility** .......................................................... 5-4
  - Entering Setup .................................................. 5-4
  - Setup Screens ................................................... 5-5
**Main Menu** ................................................................. 5-6
  - System Time & Date (Main Menu) ........................... 5-6
  - SATA Port 1/2/3 (Main Menu) ............................... 5-7
  - System/Extended Memory: (Main Menu) ................... 5-7
  - BIOS Revision/VGA Card etc. (Main Menu) ............... 5-7
**Advanced Menu** ........................................................... 5-8
  - Installed O/S (Advanced Menu) ............................. 5-8
  - SATA Mode Selection (Advanced Menu) .................... 5-9
  - Legacy USB Support (Advanced Menu) ..................... 5-9
  - Boot-time Diagnostic Screen: (Advanced Menu) ....... 5-9
  - Legacy OS Boot (Advanced Menu) .......................... 5-9
  - Reset Configuration Data: (Advanced Menu) ............ 5-10
  - Battery Low Alarm Beep: (Advanced Menu) ............ 5-10
**Security Menu** ............................................................. 5-11
  - Security Menu ................................................... 5-11
  - Set Supervisor Password (Security Menu) ................ 5-11
**Boot Menu** ................................................................. 5-12
  - Fixed disk boot sector: (Security Menu) ................. 5-12
**Exit Menu** ................................................................. 5-13

# Upgrading The Computer

**Overview** ................................................................. 6-1
  - When Not to Upgrade .......................................... 6-2
  - Removing the Battery ........................................... 6-3
  - Upgrading the Hard Disk Drive ............................... 6-4
  - Upgrading the System Memory (RAM) ..................... 6-7
  - Upgrading the Optical (CD/DVD) Device ................. 6-10

# Modules

**Overview** ................................................................. 7-1
  - Bluetooth Module .............................................. 7-2
  - Bluetooth Configuration in Windows Vista ............... 7-3
  - PC Camera Module .............................................. 7-6
  - PC Camera Driver Installation ............................... 7-7
  - PC Camera Audio Setup ....................................... 7-8
  - Wireless LAN Module .......................................... 7-14
  - Intel® Wi-Fi Link 5100/5300 Series (802.11 a/g/n) Driver Installation ......... 7-14
  - Connecting to a Wireless Network ......................... 7-15
  - Windows Mobility Center .................................... 7-18
  - Fingerprint Reader Module .................................. 7-19
Preface

Fingerprint Reader Driver Installation ..................... 7-20
User Enrollment .......................................................... 7-21
USB TV Tuner Module ............................................... 7-24
Consumer Infrared Remote Control Unit Driver .... 7-25
TV Tuner Driver Installation ..................................... 7-25
Digital TV Broadcast Signal .................................... 7-27
TV Recording and Power Plans ............................... 7-27
Remote Control Unit ................................................ 7-27

Troubleshooting
Overview ................................................................. 8-1
Basic Hints and Tips .................................................... 8-2
Backup and General Maintenance ............................... 8-3
Viruses ...................................................................... 8-4
Upgrading and Adding New Hardware/Software ...... 8-5
Problems & Possible Solutions ................................... 8-7
Screen Resolution Error ............................................ 8-14

Interface (Ports & Jacks)
Overview ................................................................. A-1
Ports and Jacks .......................................................... A-2
Card Reader ............................................................. A-2
CATV Antenna Jack .................................................. A-2
Consumer Infrared Transceiver ............................. A-2
DC-In Jack ............................................................... A-2
DVI-Out Port ............................................................. A-2
e-SATA/USB Port ...................................................... A-3
HDMI-Out Port ........................................................ A-3
Headphone-Out Jack ............................................. A-3
Infrared (FIR) Transceiver ...................................... A-3
Line-In Jack .............................................................. A-4
Microphone-In Jack ................................................ A-4
Mini-IEEE 1394 Port ............................................... A-4
RJ-11 Phone Jack ..................................................... A-4
RJ-45 LAN Jack ....................................................... A-4
S/PDIF-Out Jack ....................................................... A-5
Security Lock Slot .................................................... A-5
USB 2.0/1.1 Ports ...................................................... A-5

NVIDIA Video Driver Controls
NVIDIA Video Driver Installation ............................... B-1
NVIDIA Control Panel ............................................. B-2
Attaching Other Displays ......................................... B-5
HDMI Audio Configuration ....................................... B-7
Display Modes ........................................................ B-9
Enabling TV Display .............................................. B-12
Changing the TV Signal Format ............................... B-13
Specifications
Processor Types ............................................................ C-2
Core Logic .................................................................... C-2
LCD .............................................................................. C-2
Security ......................................................................... C-3
Memory ......................................................................... C-3
Video Adapter Options ................................................. C-3
BIOS ............................................................................. C-3
Storage .......................................................................... C-4
Audio ............................................................................ C-4
Keyboard & Pointing Device ........................................ C-4
ExpressCard Slot .......................................................... C-4
Mini-Card Slots ............................................................ C-4
I/O Ports ........................................................................ C-5
Communication ............................................................. C-5
Operating Systems Supported ....................................... C-5
Power Management ........................................................ C-6
Power ............................................................................ C-6
Environmental Spec ...................................................... C-6
Physical Dimensions & Weight ....................................... C-6
Optional ........................................................................ C-6

Windows XP Information
DVD Regional Codes ................................................... D-2
Windows XP Start Menu & Control Panel ................... D-3
Audio Features .............................................................. D-4
Function/Hot Key Indicators ........................................ D-5
Video Features .............................................................. D-6
Display Properties & NVIDIA Control Panel ............. D-7
NVIDIA Video Driver Controls ................................... D-8
Display Devices and Modes (NVIDIA) ......................... D-10
Attaching Other Displays ............................................ D-12
HDMI Audio Configuration ......................................... D-14
HDMI Video Configuration ......................................... D-15
Power Management Features ..................................... D-16
Power Schemes ........................................................... D-16
System Power Options .............................................. D-17
Hibernate Mode vs. Shutdown .................................... D-17
Stand by Mode vs. Hibernate Mode ............................... D-17
Stand by ...................................................................... D-18
Hibernate ................................................................. D-18
Configuring the Power Button .................................... D-19
Battery Information ..................................................... D-20
New Battery ................................................................. D-20
Battery Life ................................................................. D-20
Recharging the Battery with the AC/DC Adapter .......... D-21
Proper handling of the Battery Pack ............................ D-22
# Preface

- Battery FAQ ................................................................. D-23
- Driver Installation ....................................................... D-24
- Manual Driver Installation ........................................... D-25
- Updating/Reinstalling Individual Drivers ................... D-26
- Driver Installation Procedure ....................................... D-27
- Found New Hardware Wizard ..................................... D-27
- Chipset ........................................................................ D-27
- Video ........................................................................... D-27
- Audio ........................................................................... D-27
- Modem ........................................................................ D-27
- LAN ............................................................................ D-28
- Card Reader/ExpressCard ........................................... D-28
- TouchPad ...................................................................... D-28
- Hot Key ....................................................................... D-28
- Module Drivers ............................................................ D-28
- Bluetooth Module ....................................................... D-29
- To Add a Bluetooth Device ........................................ D-32
- PC Camera Module ..................................................... D-34
- PC Camera Driver Installation .................................... D-35
- PC Camera Audio Setup ............................................. D-36
- BisonCap ..................................................................... D-37
- Set Capture File .......................................................... D-37
- Reducing Video File Size ........................................... D-38
- Eliminating Screen Flicker ......................................... D-39
- WLAN Module ........................................................... D-41
- Intel WLAN Driver Installation ................................. D-42
- Fingerprint Reader Module ........................................ D-44
- User Enrollment ........................................................ D-45
- USB TV Tuner Module ............................................... D-47
- Consumer Infrared Remote Control Unit Driver.......... D-48
- TV Tuner Driver Installation ...................................... D-48
Chapter 1: Quick Start Guide

Overview

This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the computer and to getting your system started. The remainder of the manual covers the following:

- Chapter 2 A guide to using some of the main features of the computer e.g. the storage devices (hard disk, optical device, 7-in-1 card reader, ExpressCard/34/54), Application Hot Key, TouchPad & Mouse, Audio Features & Printer.
- Chapter 3 The computer’s power management options.
- Chapter 4 The installation of the drivers and utilities essential to the operation or improvement of some of the computer’s subsystems.
- Chapter 5 An outline of the computer’s built-in software or BIOS (Basic Input Output System).
- Chapter 6 Instructions for upgrading your computer.
- Chapter 7 A quick guide to the computer’s Bluetooth, PC Camera, Wireless LAN, Fingerprint and TV Tuner modules (some of which may be optional depending on your purchase configuration).
- Chapter 8 A troubleshooting guide.
- Appendix A Definitions of the interface, ports/jacks which allow your computer to communicate with external devices.
- Appendix B Information on the NVIDIA Video driver controls.
- Appendix C The computer’s specification.
- Appendix D Information on the Window’s XP OS.
Quick Start Guide

Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful to refer to “Drivers & Utilities” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer” on page 6 - 1 in the User’s Manual. You may also find the notes marked with a 📝 of interest to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then the information contained in this Quick Start Guide should be enough to get you up and running. Eventually you should try to look through all the documentation (more detailed descriptions of the functions, setup and system controls are covered in the remainder of the User’s Manual), but do not worry if you do not understand everything the first time. Keep this manual nearby and refer to it to learn as you go. You may find it useful to refer to the notes marked with a 📝 as indicated in the margin. For a more detailed description of any of the interface ports and jacks see “Interface (Ports & Jacks)” on page A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the 🚨 symbol. Also please note the safety and handling instructions as indicated in the Preface.

Not Included
Operating Systems (e.g. Windows Vista/ Windows XP etc.) and applications (e.g. word processing, spreadsheet and database programs) have their own manuals, so please consult the appropriate manuals.
Model Differences
This notebook series includes two different design types, however only one design is pictured in this manual.

Drivers
If you are installing new system software, or are re-configuring your computer for a different system, you will need to install the appropriate drivers. Drivers are programs which act as an interface between the computer and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order listed in Table 4-1, on page 4-3. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If your system hasn't been properly configured (your service representative may have already done that for you), refer to “Drivers & Utilities” on page 4-1 for installation instructions.

Ports and Jacks
See “Ports and Jacks” on page A-2 for a description of the interface (ports & jacks) which allow your computer to communicate with external devices, connect to the internet etc.
Quick Start Guide

System Software

Your computer may already come with system software pre-installed. Where this is not the case, or where you are re-configuring your computer for a different system, you will find the following operating systems are supported:

<table>
<thead>
<tr>
<th>Operating System &amp; Version</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>*Windows XP (Home Edition or Professional)</td>
<td>*Note: For information on the Windows XP OS (specifically power, video and driver information) see “Windows XP Information” on page D - 1.</td>
</tr>
<tr>
<td>Windows Vista - Service Pack 1 (64-bit) Home Basic Edition</td>
<td>In order to run Windows Vista without limitations or decreased performance, your computer requires a minimum 1GB of system memory (RAM).</td>
</tr>
<tr>
<td>Windows Vista - Service Pack 1 (64-bit) Home Premium/Business/Enterprise/Ultimate Editions</td>
<td>Make sure you install Windows Vista Service Pack 1 (or a Windows Vista version which includes Service Pack 1) before installing any drivers. Go to the Microsoft website for download details, or contact your service center.</td>
</tr>
</tbody>
</table>

*Note: For information on the Windows XP OS (specifically power, video and driver information) see “Windows XP Information” on page D - 1.
**System Startup**

1. Remove all packing materials, and place the computer on a stable surface.
2. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
3. Attach the AC/DC adapter to the DC-In jack at the rear of the computer, then plug the AC power cord into an outlet, and connect the AC power cord to the AC/DC adapter.
4. Move the left LCD latch towards the unlock position, and move the right latch outwards towards the sides of the computer, and hold it in position, to release the top cover.
5. Use one hand to raise the lid/LCD to a comfortable viewing angle; use the other hand (as illustrated in Figure 1 - 1 below) to support the base of the computer (**Note**: Never lift the computer by the lid/LCD).
6. Raise the lid/LCD to a comfortable viewing angle, and press the power button.

![Figure 1 - 1 - Opening the Lid/LCD/Computer with AC/DC Adapter Plugged-In](image)

**Shutdown**

Note that you should always shut your computer down by choosing the Shut Down command from the Lock Button Menu in Windows Vista. This will help prevent hard disk or system problems.
System Map: LCD Panel Open

1. Optional Built-In PC Camera
2. LCD
3. Hot Key Buttons
4. Power Button
5. Keyboard
6. TouchPad and Buttons
7. Fingerprint Reader Module (optional)
8. LED Indicators
9. Built-In Microphone

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices (e.g. WLAN or Bluetooth) aboard aircraft is usually prohibited. Make sure any wireless modules are OFF if you are using the computer aboard aircraft.

Use the appropriate function key combination (see Table 1 - 4, on page 1 - 9) to toggle power to any wireless modules, and check the LED indicators to see if any modules are powered on or not (see Table 1 - 2, on page 1 - 7).
LED Indicators

The LED indicators on the computer display helpful information about the current status of the computer.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Color</th>
<th>Description</th>
<th>Icon</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Power Icon]</td>
<td>Green</td>
<td>The Computer is On</td>
<td>![Battery Icon]</td>
<td>Orange</td>
<td>The Battery is Charging</td>
</tr>
<tr>
<td>Blinking Green</td>
<td>Blinking Green</td>
<td>The Computer is In Sleep Mode</td>
<td>Blinking Orange</td>
<td>Blinking Orange</td>
<td>The Battery has Reached Critically Low Power Status</td>
</tr>
<tr>
<td>Orange</td>
<td>Blinking Orange</td>
<td>The AC/DC Adapter is Plugged In</td>
<td>Green</td>
<td>Green</td>
<td>Hard Disk Activity</td>
</tr>
<tr>
<td>![Num Lock Icon]</td>
<td>Green</td>
<td>Number Lock is Activated</td>
<td>![Disk Icon]</td>
<td>Green</td>
<td>Hard Disk Activity</td>
</tr>
<tr>
<td>![Caps Lock Icon]</td>
<td>Green</td>
<td>Caps Lock is Activated</td>
<td>![Bluetooth Icon]</td>
<td>Orange</td>
<td>The Bluetooth Module is Powered On</td>
</tr>
<tr>
<td>![Scroll Lock Icon]</td>
<td>Green</td>
<td>Scroll Lock is Activated</td>
<td>![WLAN Icon]</td>
<td>Green</td>
<td>The WLAN Module is Powered On</td>
</tr>
</tbody>
</table>

*Table 1 - 2 - LED Indicators*
Hot Key Buttons & Keyboard

These buttons give instant access to the default Internet browser and e-mail program, and to Silent Mode* with one quick button press. To use the “user-defined application Hot Key Button”, you must install the driver (see “Hot Key” on page 4 - 6). See “TouchPad and Buttons/Mouse” on page 2 - 8 for configuration instructions.

<table>
<thead>
<tr>
<th>Hot Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>📧</td>
<td>Activate the Default E-Mail Browser</td>
</tr>
<tr>
<td>🌐</td>
<td>Activate the Default Internet Program</td>
</tr>
<tr>
<td>🕹️</td>
<td>Toggle *Silent Mode (for power saving)</td>
</tr>
</tbody>
</table>

*When enabled, Silent Mode will reduce fan noise and save power consumption. Note this may reduce computer performance.

Table 1 - 3 - Hot Key Buttons

The keyboard has a numerical keypad for easy numeric data input, and features Function Keys to allow you to change operational features instantly.

Activate the Number Lock feature by pressing the Num Lk key at the top right of the keyboard. You may check if Number Lock is enabled by looking at the LED status indicators.

Some software applications allow the number-keys to be used with Alt to produce special characters. These special characters can only be produced by using the numeric keypad. Regular number keys (in the upper row of the keyboard) will not work. Make sure that Num Lk is on.
Function/Hot Key Indicators

The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition to the basic function key combinations; visual indicators (see the table below) are available when the hot key utility is installed (see “Hot Key” on page 4 - 6). After installing the driver an icon will appear in the taskbar.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fn + ~</td>
<td>Play/Pause (in Audio/Video Programs)</td>
<td>Fn + F8/F9</td>
<td>Brightness Decrease/Increase</td>
</tr>
<tr>
<td>Fn + F1</td>
<td>TouchPad Toggle</td>
<td>Fn + F10</td>
<td>PC Camera Power Toggle</td>
</tr>
<tr>
<td>Fn + F2</td>
<td>Turn LCD Backlight Off (Press a key to or use TouchPad to turn on)</td>
<td>Fn + F11</td>
<td>WLAN Module Power Toggle</td>
</tr>
<tr>
<td>Fn + F3</td>
<td>Mute Toggle</td>
<td>Fn + F12</td>
<td>Bluetooth Module Power Toggle</td>
</tr>
<tr>
<td>Fn + F4</td>
<td>Sleep Toggle</td>
<td>Fn + Scr Lk</td>
<td>Scroll Lock Toggle</td>
</tr>
<tr>
<td>Fn + F5/F6</td>
<td>Volume Decrease/Increase</td>
<td></td>
<td>*Silent Mode Toggle</td>
</tr>
<tr>
<td>Fn + F7</td>
<td>Display Toggle</td>
<td></td>
<td>*When enabled, Silent Mode will reduce fan noise and save power consumption. Note this may reduce computer performance.</td>
</tr>
</tbody>
</table>

*Table 1 - 4 - Function/Hot Key Combo Indicators*
**Quick Start Guide**

**Figure 1 - 4**

**Front View**

1. LCD Latches
2. Line-In Jack
3. Headphone-Out Jack
4. Microphone-In Jack
5. S/PDIF-Out Jack
6. LED Indicators
7. Infrared Transceiver & Consumer Infrared Transceiver
8. Vent/Fan Intake/Outlet
9. HDMI-Out Port
10. DVI-Out Port
11. Combined eSATA/USB Port
12. USB 2.0 Port
13. DC-In Jack

---

**System Map: Front & Rear Views**

---

**Overheating**

To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intake/Outlet while the computer is in use.

**USB Ports**

Note that the connections to the USB ports only fit one way, do not force them.

---

See “Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your computer to communicate with external devices, connect to the internet etc.
**Mini-IEEE 1394 Port**

The Mini-IEEE 1394 port only supports SELF POWERED IEEE 1394 devices.

**ExpressCard Slot**

The ExpressCard Slot accepts either ExpressCard/34 or ExpressCard/54 formats.

**7-in-1 Card Reader**

The card reader allows you to use the most popular digital storage card formats:

- MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) /
- MS Pro (Memory Stick Pro) / MS Duo (requires PC adapter) /
- Mini SD (requires PC adapter) / RS MMC (requires PC adapter)

See “Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your computer to communicate with external devices, connect to the internet etc.
System Map: Left View

1. Speaker
2. Security Lock Slot
3. Optional Device Drive Bay (for CD/DVD Device, see page 2-3)

Changing DVD Regional Codes

Go to the Control Panel and double-click Device Manager (Hardware and Sound), then click the + next to DVD/CD-ROM drives. Double-click on the DVD-ROM device to bring up the Properties dialogue box, and select the DVD Region (tab) to bring up the control panel to allow you to adjust the regional code (see “DVD Regional Codes” on page 2-5).

DVD region detection is device dependent, not OS-dependent. You can select your module’s region code 5 times. The fifth selection is permanent. This cannot be altered even if you change your operating system or you use the module in another computer.

CD/DVD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to an unexpected power interruption) you may push the end of a straightened paper clip into the emergency eject hole. Do not use a sharpened pencil or any object that may break and become lodged in the hole. Don’t try to remove a floppy disk/CD/DVD while the system is accessing it. This may cause the system to “crash.”
System Map: Bottom View

Battery Information
Always completely discharge, then fully charge, a new battery before using it. Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges. See “Battery Information” on page 3 - 10 for full instructions.
Quick Start Guide

Windows Vista Start Menu & Control Panel

Most of the control panels, utilities and programs within Windows Vista (and most other Windows versions) are accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk drive, and a shortcut will usually be placed in the Start menu and/or the desktop. You can customize the look of the Start menu by right-clicking the Start menu and selecting Properties from the menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features in Windows (e.g. power, video, network, audio etc.). Windows Vista provides basic controls for many of the features, however many new controls are added (or existing ones are enhanced) when you install the drivers listed in Table 4 - 1, on page 4 - 3. To see all controls it may be necessary to toggle off Category View.
Video Features

You can configure display options, from the Display Settings control panel in Windows as long as the appropriate video driver is installed. For more detailed video information see “NVIDIA Video Driver Controls” on page B - 1.

To access Display Settings in Windows:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Adjust screen resolution under the Appearance and Personalization menu (or double-click Personalization > Display Settings).
3. Move the slider to the preferred setting in Resolution:  ① (Figure 1 - 9 on page 1 - 16).
4. Click the arrow, and scroll to the preferred setting In Colors:  ② (Figure 1 - 9 on page 1 - 16).
5. Click Advanced Settings (button)  ③ (Figure 1 - 9 on page 1 - 16).
6. Click GeForce..... (tab).
7. Click Start the NVIDIA Control Panel  ④ (Figure 1 - 9 on page 1 - 16) to access the control panel.
8. The NVIDIA Control Panel can also be accessed by right-clicking the desktop, and then clicking NVIDIA Control Panel (or from the NVIDIA Control Panel in the Windows control panel).

Video Card Options

Note that card types, specifications and drivers are subject to continual updates and changes. Check with your service center for the latest details on video cards supported.
Display Devices & Options

Besides the built-in LCD, you can also use an external VGA monitor (CRT)/external Flat Panel Display or TV (connected to the DVI-Out port/HDMI-Out port) as your display device.

**Figure 1 - 9 - Display Settings & NVIDIA Control Panel**

<table>
<thead>
<tr>
<th>NVIDIA Display Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single</td>
<td>One display device is used.</td>
</tr>
<tr>
<td>Clone</td>
<td>Both connected displays output the same view</td>
</tr>
<tr>
<td>Dualview</td>
<td>Both connected displays are treated as separate devices, and act as a virtual desktop</td>
</tr>
</tbody>
</table>

**Table 1 - 5 - Display Modes Available**
Power Options

The **Power Options** (**Hardware and Sound** menu) control panel icon in **Windows** (see page 1 - 14) allows you to configure power management features for your computer. You can conserve power by means of **power plans** and configure the options for the **power button**, **sleep button**, **computer lid (when closed)**, **display** and **sleep mode** from the left menu. Note that the **Power saver** plan may have an affect on computer performance.

Click to select one of the existing plans, or click **Create a power plan** in the left menu and select the options to create a new plan. Click **Change Plan Settings** and click **Change advanced power settings** to access further configuration options.

Pay attention to the instructions on battery care in “**Battery Information**” on page 3 - 10.

![Power Options](image)

**Note:** **Sleep** is the default power saving state in **Windows Vista**

*Figure 1 - 10 - Power Options*
Chapter 2: Storage Devices, Mouse, Audio & Printer

Overview

Read this chapter to learn more about the following main features and components of the computer:

- Hard Disk Drive
- Optical Device
- 7-in-1 Card Reader
- ExpressCard Slot
- TouchPad and Buttons/Mouse
- Audio Features
- Adding a Printer
Storage Devices, Mouse, Audio & Printer

2 - 2 Hard Disk Drive

The hard disk drive is used to store your data in the computer. The hard disk can be taken out to accommodate other 2.5" serial (SATA) hard disk drives with a height of 9.5 mm. The hard disk is accessible from the bottom of your computer as seen below. Further details on removing and inserting the hard disk are available in “Upgrading the Hard Disk Drive” on page 6 - 4.

Power Safety
Before attempting to access any of the internal components of your computer please ensure that the machine is not connected to the AC power, and that the machine is turned off. Also ensure that all peripheral cables, including phone lines, are disconnected from the computer.

Figure 2 - 1
Hard Disk Location
Optical Device

There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The actual device will depend on the model you purchased (see “Storage” on page C - 4). The optical device is usually labeled “Drive D:” and may be used as a boot device if properly set in the BIOS (see “Boot Menu” on page 5 - 13).

Loading Discs

To insert a CD/DVD, press the open button 1 and carefully place a CD/DVD onto the disc tray with label-side facing up (use just enough force for the disc to click onto the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks” and you are ready to start. The busy indicator 2 will light up while data is being accessed, or while an audio/video CD, or DVD, is playing. If power is unexpectedly interrupted, insert an object such as a straightened paper clip into the emergency eject hole 3 to open the tray.

Sound Volume Adjustment

How high the sound volume can be set depends on the setting of the volume control within Windows. Click the Volume icon on the taskbar to check the setting.

Peripherals must be connected before you turn on the system.
Handling CDs or DVDs

Proper handling of your CDs/DVDs will prevent them from being damaged. Please follow the advice below to make sure that the data stored on your CDs/DVDs can be accessed.

Note the following:

- Hold the CD or DVD by the edges; do not touch the surface of the disc.
- Use a clean, soft, dry cloth to remove dust or fingerprints.
- Do not write on the surface with a pen.
- Do not attach paper or other materials to the surface of the disc.
- Do not store or place the CD or DVD in high-temperature areas.
- Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
- Do not bend the CD or DVD.
- Do not drop or subject the CD or DVD to shock.
DVD Regional Codes
To change the DVD regional codes see “Changing DVD Regional Codes” on page 1 - 12.

<table>
<thead>
<tr>
<th>Region</th>
<th>Geographical Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>USA, Canada</td>
</tr>
<tr>
<td>2</td>
<td>Western Europe, Japan, South Africa, Middle East &amp; Egypt</td>
</tr>
<tr>
<td>3</td>
<td>South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, Hong Kong</td>
</tr>
<tr>
<td>4</td>
<td>South &amp; Central America, Mexico, Australia, New Zealand</td>
</tr>
<tr>
<td>5</td>
<td>N Korea, Russia, Eastern Europe, India &amp; Most of Africa</td>
</tr>
<tr>
<td>6</td>
<td>China</td>
</tr>
</tbody>
</table>
7-in-1 Card Reader

The card reader allows you to use some of the latest digital storage cards. Push the card into the slot and it will appear as a removable device, and can be accessed in the same way as your hard disk(s). Make sure you install the Card Reader driver (see “Card Reader/ExpressCard” on page 4 - 6).

- MMC (MultiMedia Card)
- SD (Secure Digital)
- MS (Memory Stick)
- MS (Memory Stick Pro)
- MS Duo (requires PC adapter*)
- Mini SD (requires PC adapter*)
- RS MMC (requires PC adapter*)

*Note: The PC adapters are usually supplied with these cards.
ExpressCard Slot

The computer is equipped with an ExpressCard/34/54 slot that reads Express Card/34 and ExpressCard/54 formats. ExpressCards are the successors to PCMCIA (PC Cards).

ExpressCard/54 is used for applications which require a larger interface slot, e.g. CompactFlash card reader. The number denotes the card width; 54mm for the Express Card/54 and 34mm for the ExpressCard/34. Make sure you install the ExpressCard driver (see “Card Reader/ExpressCard” on page 4 - 6).

Inserting and Removing ExpressCards

- Align the ExpressCard with the slot and push it in until it locks into place (as pictured in the generic figure below).
- To remove an ExpressCard, simply press the card to eject it.

ExpressCard Slot Cover

Make sure you keep the cover in the ExpressCard slot when not in use. This will help prevent foreign objects and/or dust getting in to the ExpressCard Slot.

Figure 2-4

1. Express Card Slot
Storage Devices, Mouse, Audio & Printer

**Mouse Driver**

If you are using an external mouse your operating system may be able to auto-configure your mouse during its installation or only enable its basic functions. Be sure to check the device's user documentation for details.

**TouchPad and Buttons/Mouse**

The TouchPad is an alternative to the mouse; however, you can also add a mouse to your computer through one of the USB ports. The TouchPad buttons function in much the same way as a two-button mouse.

Install the TouchPad driver (see page 4 - 6) and then double-click the TouchPad driver icon in the taskbar to configure the functions. You may then configure the TouchPad tapping, buttons, scrolling, pointer motion and sensitivity options to your preferences. The TouchPad may be toggled on/off by means of the **Fn + F1** key combination.

*Figure 2 - 5 Mouse Properties*
Audio Features

You can configure the audio options on your computer from the Sound control panel in *Windows*, or from the Realtek HD Audio Manager icon in the taskbar/control panel (right-click the taskbar icon to bring up the audio menu). The volume may also be adjusted by means of the Fn + F5/F6 key combination.

Sound Volume Adjustment

The sound volume level is set using the volume control within *Windows* (and the volume function keys on the computer). Click the volume icon in the taskbar to check the setting.

Right-click the icon to access the menu above.

See “HDMI Audio Configuration” on page B - 7 for a description of the audio configuration when connecting an HDMI supported display device.
Setup for Audio Recording

To record audio sources on your computer at optimum quality follow the instructions below:

1. Click **Start**, and click **Control Panel** (or point to **Settings** and click **Control Panel**) and make sure you are in **Classic View**.
2. Click **Realtek HD Audio Manager** (or right-click the taskbar icon and select **Sound Manager**).
3. Click **Microphone** (tab) in **Microphone Effects**, and then click to select **Noise Suppression** (button), or adjust the **Recording Volume** level to around 60, to obtain the optimum recording quality.
4. Click **OK** to close the control panel and save the settings.

*Figure 2 - 7*
Realtek Audio Manager - Recording Setup
Adding a Printer

The most commonly used peripheral is a printer. The following conventions will help you to add a printer; however it is always best to refer to the printer manual for specific instructions and configuration options.

**USB Printer**

Most new printers have a USB interface connection. You may use any one of the ports to connect the printer.

**Install Instructions:**
1. Set up the printer according to its instructions (unpacking, paper tray, toner/ink cartridge etc.).
2. Turn ON the computer.
3. Turn ON the printer.
4. Connect the printer’s USB cable to one of the USB ports on the computer.
5. *Windows* will identify the printer and either load one of its own drivers or ask you to supply one. Follow the on-screen instructions.

**Parallel Printer**

This is still a very common type of printer. The install instructions are in the sidebar (you will need to purchase a parallel to USB converter).

*Parallel Printer*

After setting up the printer attach the parallel cable to the printer.

Connect the printer’s parallel cable to the parallel to USB converter, and then plug the converter into the USB port.

Turn ON the printer, then turn ON the computer.

*Windows* will identify the printer and either load one of its own drivers or ask you to supply one. Follow the on-screen instructions.
Storage Devices, Mouse, Audio & Printer
Chapter 3: Power Management

Overview

To conserve power, especially when using the battery, your computer power management conserves power by controlling individual components of the computer (the monitor and hard disk drive) or the whole system.

This chapter covers:

• The Power Sources
• Turning on the Computer
• Power Plans
• Power-Saving States
• Configuring the Power Buttons
• Battery Information

The computer uses enhanced power saving techniques to give the operating system (OS) direct control over the power and thermal states of devices and processors. For example, this enables the OS to set devices into low-power states based on user settings and information from applications.
The Power Sources

The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter

Use only the AC/DC adapter that comes with your computer. The wrong type of AC/DC adapter will damage the computer and its components (see page C - 6).

1. Attach the AC/DC adapter to the DC-In jack at the rear of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the AC/DC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery

The battery allows you to use your computer while you are on the road or when an electrical outlet is unavailable. Battery life varies depending on the applications and the configuration you're using. To increase battery life, let the battery discharge completely before recharging (see “How do I completely discharge the battery?” on page 3 - 14).

We recommend that you do not remove the battery. For more information on the battery, please refer to “Battery Information” on page 3 - 10.
Turning on the Computer

Now you are ready to begin using your computer. To turn it on simply press the power button on the front panel.

When the computer is on, you can use the power button as a Sleep/Hibernate hot-key button when it is pressed for less than 4 seconds (pressing and holding the power button for longer than this will force the computer to shut down). Use Power Options (Hardware and Sound menu) control panel in Windows Vista to configure this feature.

Forced Off

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press the power button for 4 seconds, or longer, to force the system to turn itself off.

Power Button Sleep

Sleep is the default power mode when the power button is pressed for less than 4 seconds. You may configure the options for the power button from the Power Options (Hardware and Sound menu) control panel in Windows Vista (see your OS’s documentation, or “Configuring the Power Buttons” on page 3-8 for details).
Power Management

Power Plans

The computer can be configured to conserve power by means of power plans. You can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and to send the computer into Sleep after a period of inactivity.

Click Change plan settings and then click Change advanced power settings to access further configuration options in Advanced Settings.

See Table 3 - 1, on page 3 - 9 for information on how to resume from a power-saving state.

Password

It is recommended that you enable a password on system resume in order to protect your data.

Figure 3 - 1
Power Plan Advanced Settings
Each *Windows Power Plan* will also adjust the processor performance of your machine in order to save power. This is worth bearing in mind if you are experiencing any reduced performance (especially under DC/battery power).

Choose **High performance** for maximum performance when the computer is powered from an AC power source. Choose the **Power saver** (bear in mind that this scheme may slow down the overall performance of the computer in order to save power) for maximum power saving when the computer is battery (DC power) powered.
Power Management

Power-Saving States

You can use power-saving states to stop the computer’s operation and restart where you left off. **Sleep** is the default power-saving state in *Windows Vista*.

Earlier versions of *Windows* used Stand By and Hibernate as system power-saving states. *Windows Vista* combines the features of Stand By and Hibernate into the default **Sleep** power-saving state.

**Sleep**

In **Sleep** all of your work, settings and preferences are saved to memory before the system sleeps. When you are not using your computer for a certain length of time, which you specify in the operating system, it will enter **Sleep** to save power.

The PC wakes from **Sleep** within seconds and will return you to where you last left off (what was on your desktop) without reopening the application(s) and file(s) you last used.

If your mobile PC in **Sleep** is running on battery power the system will use only a minimum amount of power. After an extended period the system will save all the information to the hard disk and shut the computer down before the battery becomes depleted.
Hibernate

Hibernate uses the least amount of power of all the power-saving states and saves all of your information on a part of the hard disk before it turns the system off. If a power failure occurs the system can restore your work from the hard disk; if a power failure occurs when work is saved only to memory, then the work will be lost. Hibernate will also return you to where you last left off within seconds. You should put your mobile PC into Hibernate if you will not use the computer for a period of time, and will not have the chance to charge the battery.

Shut Down

You should shut down the computer if you plan to install new hardware (don’t forget to remove the battery and follow all the safety instructions in Chapter 6), plan to be away from the computer for several days, or you do not need it to wake up and run a scheduled task. Returning to full operation from shut down takes longer than from Sleep or Hibernate.
Configuring the Power Buttons

The power/sleep button (\texttt{Fn + F4} key combo) and closed lid may be set to send the computer into a power-saving state.

Password Protection

It is recommended that you enable a password on wake up in order to protect your data. However, you can disable this setting from the Power Options menu by clicking \textit{Require a password on wakeup} in the left menu, and selecting the options (click \textit{Change settings that are currently unavailable}).

![Figure 3 - 4: Power Options Define Power Buttons](image)

3 - 8 Configuring the Power Buttons
Resuming Operation
You can resume operation from power-saving states by pressing the power button, or in some cases pressing the sleep button (\textit{Fn} + \textit{F4} key combo).

<table>
<thead>
<tr>
<th>Power Status</th>
<th>Icon</th>
<th>Color</th>
<th>To Resume</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Off</td>
<td>Off</td>
<td></td>
<td>Press the Power Button</td>
</tr>
<tr>
<td>Sleep</td>
<td>Blinking Green</td>
<td></td>
<td>Press the Power Button</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Press the Sleep Button (\textit{Fn} + \textit{F4} Key Combo)</td>
</tr>
<tr>
<td>Hibernate</td>
<td>Off (battery)</td>
<td>Orange (AC/DC adapter)</td>
<td>Press the Power Button</td>
</tr>
<tr>
<td>Display Turned Off</td>
<td>Green</td>
<td></td>
<td>Press a Key or Move the Mouse/Touchpad</td>
</tr>
</tbody>
</table>

Table 3-1 Resuming Operation

Closing the Lid
If you have chosen to send the computer to \textbf{Sleep} when the lid is closed, raising the lid will wake the system up.

Power Button
When the computer is on, you can use the power button as a Sleep/Hibernate hot-key button when it is pressed for less than \textbf{4 seconds} (pressing and holding the power button for longer than this will force shut the computer to shut down).
Battery Information

Please follow these simple guidelines to get the best use out of your battery.

Battery Power

Your computer’s battery power is dependent upon many factors, including the programs you are running, and peripheral devices attached. You can set actions to be taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from power plan Advanced Settings (see Figure 3 - 1 on page 3 - 4).

Click the battery icon in the taskbar to see the current battery level and charge status.
Conserving Battery Power

• Use a **power plan** that conserves power (e.g. **Power saver**), however note that this may have an affect on computer performance.

• Lower the brightness level of the LCD display. The system will decrease LCD brightness slightly to save power when it is not powered by the AC/DC adapter.

• Reduce the amount of time before the display is turned off.

• Close wireless, Bluetooth, modem or communication applications when they are not being used.

• Disconnect/remove any unnecessary external devices e.g. USB devices, ExpressCards etc.

---

**Figure 3 - 6**

Windows Mobility Center

The **Windows Mobility Center** control panel provides an easy point of access for information on battery status, power plans used and wireless device status etc.
Battery Life

Battery life may be shortened through improper maintenance. To optimize the life and improve its performance, fully discharge and recharge the battery at least once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to remove the battery for any reason see “Removing the Battery” on page 6 - 3.

New Battery

Always completely discharge, then fully charge, a new battery (see “Battery FAQ” on page 3 - 14 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter

The battery pack automatically recharges when the AC/DC adapter is attached and plugged into an electrical outlet. If the computer is powered on, and in use, it will take several hours to fully recharge the battery. When the computer is turned off but plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indicators” on page 1 - 7 for information on the battery charge status, and to “Battery Information” on page 3 - 10 for more information on how to maintain and properly recharge the battery pack.)
Power Management

Proper handling of the Battery Pack

- DO NOT disassemble the battery pack under any circumstances
- DO NOT expose the battery to fire or high temperatures, it may explode
- DO NOT connect the metal terminals (+, -) to each other

Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being dropped), or any unusual smells emanating from the notebook battery, shut your computer down immediately and contact your service center. If the battery has been dropped we do not recommend using it any further, as even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire. It is recommended that you replace your computer battery every two years.

Caution

Danger of explosion if battery is incorrectly replaced.

Replace only with the same or equivalent type recommended by the manufacturer. Discard used battery according to the manufacturer’s instructions.
Battery FAQ
How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t turn off the computer even if a message indicates the battery is critically low, just let the computer use up all of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.
3. Click Change plan settings (after saving it) and click Change advanced power settings.
4. Scroll down to **Battery** and click + to expand the battery options.
5. Choose the options below (click **Yes** if a warning appears):

- Low battery levels = 0%
- Critical battery Levels = 0%
- Low battery action = Do Nothing
- Critical battery action (On battery) = Shut Down
- Critical battery action (Plugged in) = Do Nothing
How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges.
Chapter 4: Drivers & Utilities

This chapter deals with installing the drivers and utilities essential to the operation or improvement of some of the computer’s subsystems. The system takes advantage of some newer hardware components for which the latest versions of most available operating systems haven’t built in drivers and utilities. Thus, some of the system components won’t be auto-configured with an appropriate driver or utility during operating system installation. Instead, you need to manually install some system-required drivers and utilities.

What to Install

The Device Drivers & Utilities + User’s Manual disc contains the drivers and utilities necessary for the proper operation of the computer.

Table 4 - 1, on page 4 - 3 lists what you need to install and it is very important that the drivers are installed in the order indicated (see “Driver Installation” on page D - 24 for Windows XP driver information).

Module Driver Installation

The procedures for installing drivers for the PC Camera WLAN, Fingerprint and TV Tuner modules are provided in “Modules” on page 7 - 1.
Drivers & Utilities

Driver Installation

Insert the Device Drivers & Utilities + User’s Manual disc and click Install Drivers (button), or Option Drivers (button) to access the Optional driver menu.

1. Check the driver installation order from Table 4 - 1, on page 4 - 3 (the drivers must be installed in this order) which is the same as that listed in the Drivers Installer menu below.

2. Click to select the driver you wish to install, after installing each driver it will become grayed out. If you need to reinstall any driver, click the Unlock button (you should uninstall the driver first).

3. Follow the instructions for each individual driver installation procedure as listed on the following pages.

Figure 4 - 1 - Drivers Installer Screen 1

Figure 4 - 2 - Drivers Installer Screen 2

4 - 2 Driver Installation
Drivers & Utilities

Table 4 - 1 - Driver Installation

<table>
<thead>
<tr>
<th>Driver - Windows Vista with Service Pack 1</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chipset</td>
<td>Page 4 - 5</td>
</tr>
<tr>
<td>Video</td>
<td>Page 4 - 5</td>
</tr>
<tr>
<td>Audio</td>
<td>Page 4 - 5</td>
</tr>
<tr>
<td>Modem</td>
<td>Page 4 - 6</td>
</tr>
<tr>
<td>LAN</td>
<td>Page 4 - 6</td>
</tr>
<tr>
<td>Card Reader/ExpressCard</td>
<td>Page 4 - 6</td>
</tr>
<tr>
<td>TouchPad</td>
<td>Page 4 - 6</td>
</tr>
<tr>
<td>Hot Key</td>
<td>Page 4 - 6</td>
</tr>
<tr>
<td>PC Camera Module</td>
<td>Page 7 - 6</td>
</tr>
<tr>
<td>Wireless LAN Module</td>
<td>Page 7 - 14</td>
</tr>
<tr>
<td>Fingerprint Reader Module</td>
<td>Page 7 - 20</td>
</tr>
<tr>
<td>USB TV Tuner Module</td>
<td>Page 7 - 25</td>
</tr>
</tbody>
</table>

Manual Driver Installation

Click **Browse CD** (button) in the *Drivers Installer* application and browse to the executable file in the appropriate driver folder.

Windows Update

After installing all the drivers make sure you enable **Windows Update** in order to get all the latest security updates etc. (all updates will include the latest hotfixes from Microsoft). See “**Windows Update**” on page 4 - 7 for instructions.

Windows Vista Service Pack 1

Make sure you install **Windows Vista Service Pack 1** (or a **Windows Vista** version which includes Service Pack 1) before installing any drivers. Go to the Microsoft website for download details, or contact your service center.
Drivers & Utilities

Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it may be necessary to uninstall the original driver. To do this go to the Control Panel in the Windows OS and double-click the Programs and Features icon (Programs > Uninstall a program). Click to select the driver (if it is not listed see below) and click Uninstall, and then follow the on screen prompts (it may be necessary to restart the computer). Reinstall the driver as outlined in this chapter.

If the driver is not listed in the Programs and Features menu:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click Device Manager (Hardware and Sound > Device Manager).
3. Double-click the device you wish to update/reinstall the driver for (you may need to click “+” to expand the selection).
4. Click Driver (tab) and click the Update Driver or Uninstall button and follow the on screen prompts.

User Account Control (Win Vista)
If a User Account Control prompt appears as part of the driver installation procedure, click Continue or Allow, and follow the installation procedure as directed.

Windows Security Message
If you receive a Windows security message as part of the driver installation process. Just click “Install this driver software anyway” or “Install” to continue the installation procedure.

You will receive this message in cases where the driver has been released after the version of Windows you are currently using. All the drivers provided will have already received certification for Windows.

New Hardware Found
If you see the message “New Hardware Found” during the installation procedure (other than when outlined in the driver install procedure), click Cancel to close the window, and follow the installation procedure.
Driver Installation Procedure

Insert the *Device Drivers & Utilities + User’s Manual* disc and click *Install Drivers* (button), or *Option Drivers* (button) to access the *Optional* driver menu.

**Chipset**
1. Click 1. *Install Chipset Driver > Yes.*
2. Click *Next > Yes > Next > Next.*
3. Click *Finish* to restart the computer.

**Video**
1. Click 2. *Install Video Driver > Yes.*
2. Click *Next.*
3. Click *Finish* to restart the computer.

**Audio Drivers**

Note that **two** drivers are provided on the disc for the **Audio system**.

The driver included in the *Drivers Installer* menu has already received certification for *Windows*. A second driver is included (which may resolve some known issues with the original driver), which at time of going to press, has not yet received certification for *Windows*. You can install this latest driver as indicated.

1. DO NOT install the Audio driver from the Drivers Installer menu.
2. Click *Back* and click *Browse CD*.
3. Browse to the following location on the *Device Drivers & Utilities + User’s Manual disc* (note that D: is the CD/DVD device drive letter, however your system may have designated a different device drive letter):

   For *Windows Vista 64-bit/32-bit*:
   D:\Drivers\03AudioSP\setup.exe.

**Audio**

1. Click 3. *Install Audio Driver > Yes.*
2. Click *Next.*
3. Click *Finish* to restart the computer.
Drivers & Utilities

Modem
1. Click 4. Install Modem Driver > Yes.
2. Click OK.
3. The modem is now ready for configuration.

LAN
1. Click 5. Install LAN Driver > Yes.
2. Click Next > Install.
3. Click Finish.

Card Reader/ExpressCard
1. Click 6. Install Cardreader Driver > Yes.
2. Click Next > Install.
3. Click Finish.

TouchPad
1. Click 7. Install Touchpad Driver > Yes.
2. Click Next > Finish.
3. Click Restart Now to restart the computer.

Hot Key
1. Click 8. Install Hotkey Utility > Yes.
2. Click Next > Install.
3. Click Finish > Finish to restart your computer.

Modem Country Selection
Go to the Phone and Modem Options control panel (Hardware and Sound) and make sure the modem country selection is appropriate for you.
Optional Drivers
See the pages indicated for the driver installation procedures for any modules included in your purchase option.

Bluetooth Module
Note: The operating system is the default setting for Bluetooth control in Windows Vista, and does not require a driver. See “Bluetooth Module” on page 7 - 2 for configuration instructions.

PC Camera Module
See the install procedure in “PC Camera Driver Installation” on page 7 - 7.

Wireless LAN Module
See the appropriate install procedure for your WLAN module in “Wireless LAN Module” on page 7 - 14.

---

Windows Update
After installing all the drivers make sure you enable Windows Update in order to get all the latest security updates etc. (all updates will include the latest hotfixes from Microsoft).

To enable Windows Update make sure you are connected to the internet:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Check for updates (Security), or double-click Security Center and click Windows Update.
3. Double-click Check for updates (button).
4. The computer will now check for updates (you need to be connected to the internet).
5. Click Install now (button) to install the updates.
Drivers & Utilities

Fingerprint Reader Module
See the install procedure in “Fingerprint Reader
Driver Installation” on page 7-20.

TV Tuner Module
See the install procedure in “USB TV Tuner Module”
on page 7-24.
Chapter 5: BIOS Utilities

Overview

This chapter gives a brief introduction to the computer’s built-in software:

**Diagnostics:** The POST (Power-On Self Test)

**Configuration:** The Setup utility

If your computer has never been set up, or you are making important changes to the system (e.g. hard disk setup), then you should review this chapter first and note the original settings found in Setup. Even if you are a beginner, keep a record of the settings you find and any changes you make. This information could be useful if your system ever needs servicing.

There is one general rule: *Don’t make any changes unless you are sure of what you are doing.* Many of the settings are required by the system, and changing them could cause it to become unstable or worse. If you have any doubts, consult your service representative.

---

**BIOS Settings Warning**

Incorrect settings can cause your system to malfunction. To correct mistakes, return to Setup and restore the Setup Defaults with <F9>.

---
The Power-On Self Test (POST)

Each time you turn on the computer, the system takes a few seconds to conduct a POST, including a quick test of the on-board RAM (memory).

As the POST proceeds, the computer will tell you if there is anything wrong. If there is a problem that prevents the system from booting, it will display a system summary and prompt you to run Setup.

If there are no problems, the Setup prompt will disappear and the system will load the operating system. Once that starts, you can’t get into Setup without rebooting.
Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-fatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously wrong with your system. Take the computer to your service representative or authorized service center as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying the problem (make a note of this message!) followed by the prompt:

• Press <F1> to resume
• <F2> to enter Setup

Press F1 to see if the boot process can continue. It may work, without the correct configuration.

Press F2 to run the Setup program and try to correct the problem. If you still get an error message after you change the setting, or if the “cure” seems even worse, call for help.
The Setup Utility

The Phoenix Setup utility tells the system how to configure itself and manage basic features and subsystems (e.g. port configuration).

Entering Setup

To enter Setup, turn on the computer and press F2 during the POST. The prompt (Press F2 to Enter Setup) seen in Figure 5 - 1 on page 5 - 2 is usually present for a few seconds after you turn on the system. If you get a “Keyboard Error”, (usually because you pressed F2 too quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and then hold down F2 when prompted. The Setup main menu will appear.
Setup Screens
The following pages contain additional advice on portions of the Setup.

Along the top of the screen is a menu bar with menu headings. When you select a heading, a new screen appears. Scroll through the features listed on each screen to make changes to Setup.

Instructions on how to navigate each screen are in the box along the bottom of the screen. If these tools are confusing, press F1 to call up a General Help screen, and then use the arrow keys to scroll up or down the page.

The Item Specific Help on the right side of each screen explains the highlighted item and has useful messages about its options.

If you see an arrow ➤ next to an item, press Enter to go to a sub-menu on that subject. The sub-menu screen that appears has a similar layout, but the Enter key may execute a command.
System Time & Date (Main Menu)
The hour setting uses the 24-hour system (i.e., ØØ = midnight; 13 = 1 pm). If you can change the date and time settings in your operating system, you will also change these settings. Some applications may also alter data files to reflect these changes.
**SATA Port 1/2/3 (Main Menu)**
Pressing **Enter** opens the sub-menu to show the configuration of a hard disk or optical device drive on the computer’s SATA Ports. Use the **Auto** (Type:) setting to have the items configured automatically for you.

**System/Extended Memory: (Main Menu)**
This item contains information on the system memory, and is not user configurable. The system will auto detect the amount of memory installed.

**BIOS Revision/VGA Card etc. (Main Menu)**
This item contains information on the BIOS version and video card etc., and is not user configurable.
Advanced Menu

Installed O/S (Advanced Menu)
This setting tells the computer what kind of operating system you’re using. Make sure you choose the correct setting for your O/S in order to prevent system problems. Note: If you select the Vista O/S then the SATA Mode Selection menu will become available. If you are installing the Windows XP O/S make sure you have set the appropriate operating system here in order to prevent system problems.
SATA Mode Selection (Advanced Menu)
This menu is only available if you select the Vista O/S as your operating system. You can configure SATA (Serial ATA) control to operate in either IDE (native/compatible) or AHCI (Advanced Host Controller Interface) modes from this menu. The SATA mode should be set to AHCI mode for this system (unless you are sure your hard disk can only operate in IDE mode). If you are unsure of the mode your hard disk supports contact your service center. Note that the SATA mode should be set to AHCI to support eSATA port hot-swapping.

Legacy USB Support (Advanced Menu)
Use this menu item to enable/disable the support for Legacy Universal Serial Bus.

Boot-time Diagnostic Screen: (Advanced Menu)
Use this menu item to enable/disable the Boot-time Diagnostic Screen (or POST screen - see “The Power-On Self Test (POST)” on page 5 - 2).

Legacy OS Boot (Advanced Menu)
Enable this item to support only system boot from the Legacy OS (e.g Windows Vista). If disabled the system will attempt to boot from the EFI (Extensible Firmware Interface) before the Legacy OS.
Reset Configuration Data: (Advanced Menu)
This item is set to No as default. You can change the setting to Yes if you have installed a new add-on which has reconfigured the system, resulting in such a serious system conflict that the operating system is unable to boot.

Battery Low Alarm Beep: (Advanced Menu)
Use this menu item to enable/disable the battery low alarm beep.
Set Supervisor Password (Security Menu)
You can set a password for access to the **Phoenix SecureCore(tm) Setup Utility**. This will not affect access to the computer OS, (only the **Phoenix SecureCore(tm) Setup Utility**).

---

**Security Menu**

![Phoenix SecureCore(tm) Setup Utility](image)

<table>
<thead>
<tr>
<th>Main</th>
<th>Advanced</th>
<th>Security</th>
<th>Boot</th>
<th>Exit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supervisor Password Is:</td>
<td>Clear</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>User Password Is:</td>
<td>Clear</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set Supervisor Password</td>
<td>Enabled</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Password on boot:</td>
<td>[Disabled]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fixed disk boot sector:</td>
<td>[Normal]</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

**Supervisor Password** controls access to the setup utility.

**Item Specific Help**

The changes you make here affect the access to the **Setup utility** itself, and also access to your machine as it boots up after you turn it on. These settings do not affect your machine or network passwords which will be set in your software OS.
Password on boot: (Security Menu)
Specify whether or not a password should be entered to boot the computer (you may only set a password on boot if a supervisor password is enabled). If “Enabled” is selected, only users who enter a correct password can boot the system (see the warning in the sidebar). The default setting is “Disabled”.

Note: To clear existing passwords press Enter and type the existing password, then press Enter for the new password (without typing any password entry) and Enter again to confirm the password clearance.

Fixed disk boot sector: (Security Menu)
If you choose “Write-Protect” this will protect against viruses being written to the hard disk boot sector (this is not a substitute for installing an anti-virus program - see “Viruses” on page 8 - 4).
When you turn the computer on it will look for an operating system (e.g. Windows Vista) from the devices listed in this menu, and in this priority order. If it cannot find the operating system on that device, it will try to load it from the next device in the order specified in the Boot priority order. Item specific help on the right is available to help you move devices up and down the order.
Choosing to **Discard Changes**, or **Exit Discarding Changes**, will wipe out any changes you have made to the **Setup**. You can also choose to restore the original **Setup** defaults that will return the **Setup** to its original state, and erase any previous changes you have made in a previous session.
Chapter 6: Upgrading The Computer

Overview
This chapter contains information on upgrading the computer. Follow the steps outlined to make the desired upgrades. If you have any trouble or problems you can contact your service representative for further help. Before you begin you will need:

• A small crosshead or Phillips screwdriver
• A small regular slotted (flathead) screwdriver
• An antistatic wrist strap

Before working with the internal components you will need to wear an antistatic wrist strap to ground yourself because static electricity may damage the components.

The chapter includes:

• Removing the Battery
• Upgrading the Hard Disk Drive
• Upgrading the System Memory (RAM)
• Upgrading the Optical (CD/DVD) Device

Please make sure that you review each procedure before you perform it.
Upgrading The Computer

When Not to Upgrade
These procedures involve opening the system’s case, adding and sometimes replacing parts. You should **not** perform any of these upgrades if:

- Your system is still under warranty or a service contract
- You don’t have all the necessary equipment
- You’re not in the correct environment
- You doubt your abilities

Under any of these conditions, contact your service representative to purchase or replace the component(s).

Upgrading the Processor
If you want to upgrade your computer by replacing the existing processor with a faster/new one you will need to contact your customer service representative. We recommend that you do not do this yourself, since if it is done incorrectly you may damage the processor or mainboard.

Power Safety Warning
Before you undertake any upgrade procedures, make sure that you have turned off the power, and disconnected all peripherals and cables (including telephone lines). It is advisable to also remove your battery in order to prevent accidentally turning the machine on.

Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and screw(s) before turning the computer on.
Removing the Battery

If you are confident in undertaking upgrade procedures yourself, for safety reasons it is best to remove the battery.

1. Turn the computer off, turn it over and remove the battery.
2. Slide latch towards the unlock symbol and hold it in place, and lift the battery up and out of the battery bay.

Warranty Warning

Please check with your service representative before undertaking any upgrade procedures to find out if this will VOID your warranty.

Figure 6 - 1
Battery Removal
Upgrading the Hard Disk Drive

The hard disk drive(s) can be taken out to accommodate other 2.5" serial (SATA) hard disk drives with a height of 9.5mm (h) (see “Storage” on page C - 4). Follow your operating system’s installation instructions, and install all necessary drivers and utilities (as outlined in “Drivers & Utilities” on page 4 - 1), when setting up a new hard disk.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the component bay cover and remove screws 1 - 11.

HDD System Warning

New HDD’s are blank. Before you begin make sure:
You have backed up any data you want to keep from your old HDD.
You have all the CD-ROMs and FDDs required to install your operating system and programs.
If you have access to the internet, download the latest application and hardware driver updates for the operating system you plan to install. Copy these to a removable medium.

Figure 6 - 2
Component Bay Cover Screws
3. Remove the bay cover 12.

4. Remove screws 13 - 16 from the hard disk cover.
5. Slide the hard disk assembly in the direction of the arrow 17.

Figure 6 - 3
Bay Cover Removal

Figure 6 - 4
Hard Disk Assembly Removal
Upgrading The Computer

6. Carefully remove the hard disk assembly in the direction of the arrow 18.

7. Remove screws 19 - 22 to separate the hard disk from the bracket.
8. Reverse the process to install any new hard disk.
Upgrading the System Memory (RAM)

The computer has two memory sockets for 204 pin Small Outline Dual In-line (SO-DIMM) DDR II (DDR2) type memory modules (see “Memory” on page C - 3). The total memory size is automatically detected by the POST routine once you turn on your computer.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the component bay cover and remove screws 1 - 11.

*Figure 6 - 7*
Component Bay Cover Screws
Upgrading The Computer

3. Remove the bay cover 12.

4. Gently pull the two release latches (13 & 14) on the sides of the memory socket in the direction indicated by the arrows in Figure 6 - 9.

Contact Warning
Be careful not to touch the metal pins on the module’s connecting edge. Even the cleanest hands have oils which can attract particles, and degrade the module’s performance.
5. The RAM module 15 will pop-up, and you can remove it.

6. Pull the latches to release the second module if necessary.
7. Insert a new module holding it at about a 30° angle and fit the connectors firmly into the memory socket.
8. The module’s pin alignment will allow it to only fit one way. Make sure the module is seated as far into the socket as it will go. DO NOT FORCE the module; it should fit without much pressure.
9. Press the module in and down towards the mainboard until the socket levers click into place to secure the module.
10. Replace the cover and screws (see Figure 6 - 7).
11. Restart the computer to allow the BIOS will register the new memory configuration as it starts up.
Upgrading the Optical (CD/DVD) Device

1. Turn the computer off, turn it over and remove the battery.
2. Slide the latch 1 towards the unlock symbol and hold it in place.
3. Slide latch 2 (while still holding latch 1 in place) in the direction indicated by the arrow in order to push the device out of the computer.

Figure 6 - 11
Removing the CD/DVD Device
Chapter 7: Modules

Overview

This chapter contains the information on the various modules (some of which are optional) which may come with your computer, depending on the configuration purchased. If you are unsure please contact your service representative.

The chapter includes information on the following:

• Bluetooth Module
• PC Camera Module
• Wireless LAN Module
• Fingerprint Reader Module
• USB TV Tuner Module
Bluetooth Module

The **optional** Bluetooth module allows you to connect your computer to Bluetooth enabled devices such as other computers, desktop computers, mobile phones, printers, digital cameras, PDAs, headsets etc. using a short-range radio frequency.

**Use the `Fn + F12` key combination** (see *Table 1 - 4, on page 1 - 9*) **to toggle power to the Bluetooth module.** When the Bluetooth module is powered on, the LED will be **orange** and the indicator will briefly be displayed. The operating system’s **Bluetooth Devices** control panel is used to configure the Bluetooth settings in *Windows Vista*, and therefore does not require a driver.

---

**Note:**

**Bluetooth Data Transfer**

Note that the transfer of data between the computer and a Bluetooth enabled device is supported **in one direction only (simultaneous data transfer is not supported).** Therefore if you are copying a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from the Bluetooth enabled device to your computer until the file transfer process from the computer has been completed.

**Bluetooth Module & Resuming From Sleep Mode**

The Bluetooth module’s default state will be off after resuming from the **Sleep** power-saving state. Use the key combination (**Fn + F12**) to power on the Bluetooth module after the computer resumes from Sleep.
Bluetooth Configuration in Windows Vista

Setup your Bluetooth Device so the Computer Can Find it
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
2. Make the device discoverable (to do this check your device documentation).

To Turn the Bluetooth Module On
1. Press the **Fn + F12** key combination to power on the Bluetooth module.
2. A Bluetooth icon \( \text{Bluetooth Device} \) will appear in the taskbar (see sidebar).
3. You can then do any of the following to access the **Bluetooth Devices** control panel.
   - **Double-click** the icon \( \text{Bluetooth Device} \) to access the **Bluetooth Devices** control panel.
   - Click **Start**, and click **Control Panel** (or point to **Settings** and click **Control Panel**), and then click **Bluetooth Devices** (**Hardware and Sound**).
   - **Click/Right-click** the icon \( \text{Bluetooth Device} \) and choose an option from the menu.

If you cannot see the Bluetooth icon in the taskbar, access the **Bluetooth Devices** control panel. Click **Options** (tab), and make sure that **Show Bluetooth icon in the notification area** check box (Connections) has a tick inside it.

Note that you will need to check the LED indicator to see if the module is powered on or not.

*Figure 7 - 1
Bluetooth Devices & Click Icon Menu*
To Add a Bluetooth Device
1. Access the Bluetooth Devices control panel.
2. Click Options (tab), and make sure that Allow Bluetooth devices to connect to this computer check box (Connections) has a tick inside it.
3. Click Devices (tab), and then click Add.
5. Click to select “My device is set up and ready to be found”, and then click Next.
6. The Wizard will then search for any available Bluetooth devices within range.
7. Click to select the device you want to communicate with, and click Next.
8. Select an appropriate passkey option and click Next.
9. Click Finish.
To Change Settings for the Bluetooth Device
1. Access the Bluetooth Devices control panel.
2. Click on the device you want to change and click Properties to:
   • Change the name of the device (click General, type a new name and click OK).
   • Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

To Make your Computer Discoverable to Bluetooth Devices
1. Access the Bluetooth Devices control panel.
2. Click Options, and make sure that Allow Bluetooth devices to find this computer check box (Discovery) has a tick inside it.
3. Make sure that Alert me when a new Bluetooth device wants to connect check box (Connections) has a tick inside it, if you want to be notified when a Bluetooth device wants to connect.

Figure 7 - 4
Bluetooth Devices Options
PC Camera Module

The PC Camera module uses the **BisonCap** application to capture video files. Before installing the driver, make sure the PC Camera is on. **Use the Fn + F10 key combination** (see *Table 1 - 4, on page 1 - 9*) to toggle power to the PC Camera module. When the PC Camera module is powered on, the indicator will briefly be displayed. Make sure you install the drivers in the order indicated in *Table 4 - 1, on page 4 - 3*.

---

**PC Camera Device and TV Module**

If you have both an optional PC Camera and an optional TV Tuner module present, you will need to select which device to use with the **BisonCap** program. Go to the **Devices** menu in the **BisonCap** application and select the **BisonCam, NB Pro** device.
PC Camera Driver Installation
1. Insert the *Device Drivers & Utilities + User’s Manual* disc into the CD/DVD drive.
2. Click **Option Drivers** (button).
3. Click **1.Install WebCam Driver > Yes**.
4. Choose the language you prefer and click **Next > Next**.
5. Click **Finish** to restart the computer.
6. Run the **BisonCap** application program from the **BisonCam** shortcut on the desktop, or from the **BisonCam** item in the **Start > Programs/All Programs** menu (if the hardware is turned off use the **Fn + F10** key combination to turn it on again).

---

2.0M PC Camera Screen Refresh

The 2.0M PC Camera module supports a frame rate of 12 fps. If you find that the screen refresh rate is subject to lag or stuttering, then reduce the window size, or adjust the **Output Size** and/or **Color Space Compression**.

To reduce **Output Size** and/or **Color Space Compression** run the **BisonCap** application, click **Options** and select **Video Capture Pin**. Adjust the settings from the appropriate pull-down menu.
PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the audio recording options in Windows.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound (Hardware and Sound).
3. Click Recording (tab).
4. Right-click Microphone (Realtek High Definition Audio) and make sure the item is not disabled.
5. Double-click Microphone (or select Properties from the right-click menu).
6. Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to the level required.
7. Click OK and close the control panels.
8. Run the BisonCap application program from the Start > Programs/All Programs > BisonCam menu.
9. Go to the Devices menu heading and select Microphone (Realtek....) (it should have a tick alongside it).
10. Go to the Capture menu heading and select Capture Audio (it should have a tick alongside it).
Figure 7-5
Audio Setup for PC Camera

Right-click
BisonCap

BisonCap is a video viewer for general purpose video viewing and testing, and for capturing video files to .avi format.

1. Run the BisonCap program from the Start > Programs/All Programs > Bison-Cam menu (it is recommended that you set the capture file before the capture process - see Set Capture File below).
2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera Audio Setup” on page 7 - 8) and select Start Capture.
3. Click OK (the file location will be displayed in the pop-up box) to start capturing the video, and press Esc to stop the capture (you can view the file using the Windows Media Player).

Set Capture File

Prior to capturing video files you may select the Set Capture File... option in the File menu, and set the file name and location before capture (this will help avoid accidentally overwriting files). Set the name and location then click Open, then set the "Capture file size:" and click OK. You can then start the capture process as above.

Note the important information in “Reducing Video File Size” on page 7 - 11 in order to save file space, and help prevent system problems.
Reducing Video File Size

Note that capturing high resolution video files requires a substantial amount of disk space for each file. After recording video, check the video file size (right-click the file and select Properties) and the remaining free space on your hard disk (go to My Computer, right-click the hard disk, and select Properties). If necessary you can remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash drive.

Note that the Windows Vista system requires a minimum of 15GB of free space on the C: drive system partition. In order to prevent system problems it is recommended that you save the captured video file to a location other than the C: drive (see “Set Capture File” on page 7 - 10), limit the file size of the captured video (see “Pre-Allocating File Space” on page 7 - 10) or reduce video resolution (see below).

To Reduce Video Resolution Output Size:

1. Run the BisonCap program.
2. Go to Options and scroll down to select Video Capture Pin....
3. Click the Output Size drop box and select a lower resolution size in order to reduce the captured file size.
Eliminating Screen Flicker

If you find that the video screen in the BisonCap program is flickering, you can try to adjust the setting in the Video Capture Filter options.

1. Run the BisonCap program.
2. Go to Options and scroll down to select Video Capture Filter....
3. Click either 50Hz or 60Hz under Frequency in Property Page (tab).

*Figure 7 - 6
Video Capture Filter*
Modules

Zoom
The BisonCap program allows you to zoom the camera in and out.

1. Run the BisonCap/Video View program.
2. Go to Zoom and select Zoom Out/Zoom In.

Taking Still Pictures
The BisonCap program allows you to take still pictures.

1. Run the BisonCap program.
2. Go to Options and select Take Picture.
3. The picture (in JPEG format) will be placed in the Snapshot folder on the desktop.

Figure 7 - 7
Zoom/Setting

Snapshot Folder
The Snapshot folder’s default location is on the desktop. Do not move this folder or an error may appear when you try to take a still picture.

If you accidentally delete or move the folder, you can create a new Snapshot folder on the desktop in order to capture the files.
Wireless LAN Module

If you have included an Intel® Wi-Fi Link 5100/5300 Series (802.11 a/g/n) WLAN module in your purchase option, make sure that the Wireless LAN module is on before installing the driver.

Use the Fn + F11 key combination (see Table 1-4, on page 1-9) to toggle power to the Wireless LAN module. When the WLAN module is powered on, the LED will be green and the indicator will briefly be displayed. Make sure you install the drivers in the order indicated in Table 4-1, on page 4-3.

Intel® Wi-Fi Link 5100/5300 Series (802.11 a/g/n) Driver Installation

1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
2. Click Option Drivers (button).
3. Click 2. Install Wireless Lan Driver > Yes.
4. Click Next > Next.
5. Click the button to accept the license and click Next.
6. Click Next > Next > Finish.

Note: The operating system is the default setting for Wireless LAN control in Windows Vista (see overleaf).
Connecting to a Wireless Network
Make sure the Wireless LAN module is turned on.

1. Click the taskbar wireless icon , and then click Connect to a network (or right-click the icon , and then click Connect to a network).

2. In the Show list, click to choose Wireless from the drop-down menu.

3. A list of currently available networks will appear.

You can also use the Network and Sharing Center control panel in Windows (Network and Internet) to connect to any available wireless networks.
4. Click a network, and then click Connect.
5. If you do not see a network you want to connect to, click Set up a connection or network (a list of options will appear allowing manual searching, and creating a new network).

6. Move the cursor over the taskbar icon to see the connection status (see below).
7. To disconnect from the wireless network you can click the taskbar wireless icon \( \text{\includegraphics[width=0.2\textwidth]{icon.png}} \), and then select **Connect or disconnect** to access the network menu, and click **Disconnect** (or **right-click** the icon \( \text{\includegraphics[width=0.2\textwidth]{icon.png}} \), and then click **Disconnect from**).

Security Enabled Networks
You should try to make sure that any network you are connecting to is a secure network.

Connecting to unsecure networks may allow unauthorized access to your computer, documents, websites and files etc.

*Figure 7 - 12*
Disconnecting
Windows Mobility Center

The Windows Mobility Center control panel provides an easy point of access for information on battery status, power plans used and wireless device status etc.

To access the Windows Mobility Center:

1. **Click Start**, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click **Windows Mobility Center (Mobile PC)**.
3. Click the button to **Turn wireless off/on**, or click the icon to access the network menu.

![Figure 7 - 13 Windows Mobility Center](image)

7 - 18 Wireless LAN Module
Fingerprint Reader Module

The optional fingerprint reader Protector Suite Software provides a high level of security for your computer. A further level of security and control is provided in the BIOS (see “Security Menu” on page 5 - 11).

The fingerprint reader and Protector Suite Software allow you to:

• Access or Lock your computer
• Protect sensitive files
• Display and file your favorite web pages
• Fill in frequently used dialogs
• Run your favorite applications

If you have included the fingerprint reader in your purchase option you will need to install the driver as per the instructions below.

Make sure you have administrator’s rights to your computer, and have a Windows password enabled for full security protection.

Before beginning the enrollment process it is recommended that you go through the fingerprint tutorial. To run the tutorial click Start > Programs/All Programs > Protector Suite QL > Fingerprint Tutorial after installing the driver.
Fingerprint Reader Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
2. Click Option Drivers.
3. Click 3.Install FingerPrint Driver > Yes.
4. Click Software Installation.
5. Click Next > Next > Next.
6. Click Finish > Yes to restart the computer.
User Enrollment

1. Click **Start > Programs/All Programs > Protector Suite QL > User Enrollment**, or double click the taskbar icon.
2. On the first run of the program you will be asked to click the button to accept the license, and then click **OK**.
3. Click **Next** and select **“Enrollment to the hard disk”**, and click **Finish**.

4. If you have not set a **Windows** password you will be prompted to do so (note: If you have not set a password **Protector Suite QL** cannot secure access to your computer).
5. Click **Next**.
6. You will then be prompted to enter your **Windows** password.
7. Click **Next > Next** (if you have the **“Run interactive tutorial”** tickbox selected you will run through the Fingerprint Tutorial).
8. Click **Next** for each window of the tutorial (you can click the button to “**skip tutorial**” at any time).
9. Click the button above any of the fingers to begin the enrollment process for that finger.
10. Swipe the finger three times to enroll that finger.
11. Repeat the process for all the fingers you wish to enroll (see sidebar), and then click Next.
12. Click Finish.
13. Click any of the headings under “Learn more about:” to get more information on any topic.
14. Click Close.

Note that it is strongly recommended that you enroll more than one finger in case of injury etc.
15. Right-click the taskbar icon to bring up the menu that allows you to **Edit Fingerprint**, **Start Control Center**, access the **Help** menu etc. You can also run the **Control Center** etc. from the **Protector Suite QL** item in the **Programs/All Programs** menu.

16. See **“Help & Manual” on page 7 - 20** for further details.

17. If you swipe your finger over the reader at any time you can access the **Biomenu** to **lock the computer**, **register websites**, open the **Control Center** and access the **Help** menu.

18. The **Control Center** allows you to change the **Settings**, **enroll Fingerprint** and get **Help**.
USB TV Tuner Module

A CD containing drivers, software and a user guide will be supplied if your purchase configuration includes the **optional** USB TV Tuner module. In addition a driver is provided on the *Device Drivers & Utilities + User’s Manual* disc for the remote control supplied with the TV Tuner.

You will also be supplied with a remote control unit and appropriate antenna and fittings for the USB TV Tuner module.

The optional TV Tuner allows you to watch TV, play music CDs, video conference and capture still images and video on your PC.

The Cable (CATV) antenna jack will only be enabled when the TV Tuner module is installed. Make sure you install the driver before connecting the TV antenna.

**Figure 7 - 17**

**TV Tuner Ports/Jacks**

1. Infrared & Consumer Infrared Transceiver
2. Cable (CATV) Antenna Jack

---

**Modules**

**TV Antenna**

The TV antenna supplied with any TV Tuner module is intended for indoor use only. Please do not use your TV Tuner module outdoors.

**TV Tuner Remote**

Point the remote at the consumer IR transceiver to change channels, etc.
**Consumer Infrared Remote Control Unit Driver**
1. Insert the *Device Drivers & Utilities + User’s Manual* disc into the CD/DVD drive.
2. Click **Option Drivers**.
3. Click 4. Install ITE CIR Driver > Yes.
4. Click **Next > Yes > Next > Finish**.

**TV Tuner Driver Installation**
1. Insert the *MC770A Driver* disc into the CD/DVD drive and double-click the device drive icon.
2. Click **MC770A Driver V***** and S/W Encoder Setup**.
3. Choose the language you prefer, and click **Next > Next > Next > Next**.
4. Click the button to accept the license agreement, and then click **Next**.
5. Click **Next > Next**.
6. Click “**Yes, restart my computer now.**” (button) and click **Next**.
7. Click **Finish > Finish > Finish** to restart the computer.
8. Insert the *MC770A Driver* disc into the CD/DVD drive and double-click the device drive icon.
9. Click **AP Verr********** to install the application.
10. Click **Next**.
11. Click the button to accept the license agreement, and then click **Next**.
12. Click **Next** (make sure you input a User and Company Name).
13. Type in the serial number provided, and then click **Next**.
14. Choose the language you prefer, and click Next.
15. Click Next > Next > Next.
16. Click “Yes, restart my computer now.” (button) and click Next.
17. Click Finish to restart the computer.
18. Run the Hybrid DTV application from the Start > Programs/All Programs > Hybrid DTV and select the Hybrid DTV program or double-click the Hybrid DTV shortcut on the desktop.
   or
19. Run Windows Media Center directly from the Start menu (Start > Programs > Windows Media Center).
20. Windows Help and Support provides information on the Windows Media Center functions. Click Start and select Help and Support, and then type “Media Center” in the Search Help box and click the magnifying glass icon to bring up the results.

Windows Media Center
Note that the Windows Media Center software comes built-in to the Windows Vista Home Premium and Ultimate Editions only.
Digital TV Broadcast Signal
The antenna is the most crucial factor in receiving a clear digital terrestrial TV broadcast signal. The passive antenna provided should provide a clear signal when placed beside a window. If the signal is not clear then you can purchase an active antenna (it should also be placed beside a window) to improve the signal. You should also check with any related government website which provides information on digital terrestrial TV coverage for your area. Note that (unlike standard analog TV) if the digital signal is weak then no picture will appear on the TV at all.

TV Recording and Power Plans
If you intend to use the optional TV Tuner to record live TV, then go to the Power Options control panel and create a power plan (see “Power Plans” on page 3 - 4) to prevent the power saving options from adjusting the computer’s performance level.

Remote Control Unit
The remote control unit allows you to remotely start and send the system into a power saving state, to run Windows Media Center and to navigate the Media Center menus etc. The remote control unit also gives full control over all TV and video functions.
Modules
Chapter 8: Troubleshooting

Overview

Should you have any problems with your computer, before consulting your service representative, you may want to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface. If all else fails, talk to your service representative. You should also make a record of what happened and what remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call your service representative.
Troubleshooting

Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer appears not to be working.

- **Power** - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip, make sure it is actually working. Check the **LED Power Indicators** (see “LED Indicators” on page 1 - 7) to see the computer’s power status.

- **Connections** - Check all the **cables** to make sure that there are no loose **connections** anywhere.

- **Power Savings** - Make sure that the system is not in **Hibernate** or **Sleep** mode by pressing the keys configured in your **Power Options** (see “Configuring the Power Buttons” on page 3 - 8), the **Fn + F4** key combination, or power button to wake-up the system.

- **Brightness** - Check the brightness of the screen by pressing the **Fn + F8** and **F9** keys to adjust the brightness (see Table 1 - 4, on page 1 - 9).

- **Display Choice** - Press **Fn + F7** to make sure the system is not set to “external only” display.

- **Boot Drive** - Make sure there are no optical media and/or USB storage devices in any connected drive when you start up your machine (this is a common cause of the message “Invalid system disk - Replace the disk, and then press any key” / “Remove disks or other media. Press any key to restart”).
Backup and General Maintenance

- Always **backup** your important data, and keep copies of your OS and programs safe, but close to hand. Don’t forget to note the **serial numbers** if you are storing them out of their original cases, e.g. in a CD wallet.

- Run **maintenance programs** on your hard disk and OS as often as you can. You may schedule these programs to run at times when you are not using your computer. You can use those that are provided free with your OS, or buy the more powerful dedicated programs to do so.

- Write down your passwords and keep them safe (away from your computer). This is especially important if you choose to use a **Boot** password for the SCU (see “**Security Menu**” on page 5 - 11).

- Keep copies of vital **settings files** such as network, dialup settings, mail settings etc. (even if just brief notes).

---

**Warranty**

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your warranty.
Troubleshooting

Viruses

• Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm your computer and cause you to lose data. Anti-Virus programs are commercially available and the definitions file updates are usually downloadable directly from the internet.

• Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-mail attachments so take care when opening any attached file. You can configure most Anti-Virus programs to check all e-mail attachments. Note: You should also beware of files from people you know as the virus may have infected an address book and been automatically forwarded without the person’s knowledge.

• Keep a “Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic information which allows you to startup your computer) handy. You may refer to your OS’s documentation for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at least instructions on how to make one).
Upgrading and Adding New Hardware/Software

• Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are doing, otherwise you will risk severely damaging your system.

• Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what you are doing.

• Read the documentation. We can assume, since you are reading this that you are looking at the computer’s manual, but what about any new peripheral devices you have just purchased? Many problems are caused by the installation of new hardware and/or software. Always refer to the documentation of any new hardware and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

• When installing a new device always make sure the device is powered on, and in many cases you will need to restart the computer. Always check that all the cables are correctly connected.

• Make sure you have installed the drivers for any new hardware you have installed (latest driver files are usually available to download from vendor’s websites).

• Thoroughly check any recent changes you made to your system as these changes may affect one or more system components, or software programs. If possible, go back and undo the change you just made and see if the problem still occurs.
Troubleshooting

• Don’t over complicate things. The less you have to deal with then the easier the source of the problem may be found; Example - if your computer has many devices plugged into its ports, and a number of programs running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices and restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and removing devices and restarting where necessary) will often find the source of a problem, although this may be time consuming.
### Troubleshooting

#### Problems & Possible Solutions

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You turned the <strong>power on</strong> but it doesn’t work.</td>
<td><em>Battery missing / incorrectly installed.</em> Check the battery bay, make sure the battery is present and seated properly (the design of the battery only allows it to go in one way). Make sure there’s nothing interfering with the battery contacts.</td>
</tr>
<tr>
<td>The <strong>Battery LED power indicator</strong> is blinking orange.</td>
<td><em>Low Battery.</em> Plug in the AC power source. If the computer doesn’t start up immediately, turn it off then on again.</td>
</tr>
<tr>
<td>You are losing <strong>battery power</strong> too quickly.</td>
<td><em>The system is using too much power.</em> If your OS has a <em>Power Options</em> scheme [see “Power Plans” on page 3 - 4/“Power Schemes” on page D - 16] check its settings. You may also be using an ExpressCard device/USB device/external device that is drawing a lot of power.</td>
</tr>
<tr>
<td>Actual <strong>battery operating time</strong> is shorter than expected.</td>
<td><em>The battery has not been fully discharged before being recharged.</em> Make sure the battery is fully discharged and recharge it completely before reusing [see “Battery Information” on page 3 - 10/“Battery Information” on page D - 20]. Check the settings of any active power plan [see “Power Plans” on page 3 - 4/“Power Schemes” on page D - 16]. <em>A peripheral device/USB device is consuming a lot of power.</em> Turn off/remove the unused device to save power.</td>
</tr>
</tbody>
</table>
# Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The computer feels too hot.</td>
<td>Make sure the computer is properly ventilated and the vents/fan intakes are not blocked. If this doesn’t cool it down, put the system into Hibernate mode or turn it off for an hour. Make sure the computer isn’t sitting on a thermal surface (see “Overheating” on page 1 - 10). Make sure you’re using the correct adapter.  &lt;br&gt;Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a notebook which is powered on in a travel bag may cause the vents/fan intakes to be blocked.</td>
</tr>
<tr>
<td>Nothing appears on screen.</td>
<td><em>The system is in a power saving mode.</em> Toggle the Fn + F4 (see “Configuring the Power Buttons” on page 3 - 8/“Configuring the Power Button” on page D - 19).  &lt;br&gt;<em>The screen controls need to be adjusted.</em> Toggle the screen control Fn + F8/F9 key combinations. If you’re connected to an external monitor, make sure it’s plugged in and turned on. You should also check the monitor’s own brightness and contrast controls.  &lt;br&gt;<em>The computer is set for a different display.</em> Toggle the screen display key Fn + F7 combination. If an external monitor is connected, turn it on.  &lt;br&gt;<em>The screen saver is activated.</em> Press any key or touch the TouchPad.</td>
</tr>
<tr>
<td>No image appears on the external monitor I have plugged in and powered on.</td>
<td>You haven’t installed the video driver and configured it appropriately from the Control Panel. See “NVIDIA Video Driver Controls” on page B - 1/“Video Features” on page D - 6 for instructions on installing and configuring the video driver.</td>
</tr>
<tr>
<td>You forget the boot password.</td>
<td>If you forget the password, you may have to discharge the battery of the CMOS. Contact your service representative for help.</td>
</tr>
</tbody>
</table>

---

# 8 - 8 Problems & Possible Solutions
<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <strong>sound</strong> cannot be heard or the volume is very low.</td>
<td><em>The volume might be set too low.</em> Check the volume control in the <strong>Volume Control Panel</strong> in the Windows taskbar, or use the key combination <strong>Fn + F5</strong> and <strong>F6</strong> (see “Audio Features” on page 2-9/“Audio Features” on page D-4) to adjust.</td>
</tr>
<tr>
<td>The <strong>compact disc</strong> cannot be read.</td>
<td><strong>The compact disc is dirty.</strong> Clean it with a CD-ROM cleaner kit.</td>
</tr>
<tr>
<td>The <strong>compact disc tray</strong> will not open when there is a disc in the tray.</td>
<td><strong>The compact disc is not correctly placed in the tray.</strong> Gently try to remove the disc using the eject hole (see “Loading Discs” on page 2-3).</td>
</tr>
<tr>
<td>The <strong>DVD regional codes</strong> can no longer be changed.</td>
<td><strong>The code has been changed the maximum 5 times.</strong> See “DVD Regional Codes” on page 2-5/“DVD Regional Codes” on page D-2.</td>
</tr>
<tr>
<td>The <strong>TouchPad</strong> doesn’t work.</td>
<td><strong>The Touchpad has been disabled.</strong> Press the Touchpad toggle (<strong>Fn + F1</strong>) key combination (make sure you have installed the Touchpad driver).</td>
</tr>
</tbody>
</table>

Password Warning

If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The system freezes or the screen goes dark.</td>
<td>The system’s power saving features have timed-out. Use the AC/DC adapter, press a key on the keyboard, or press the sleep (Fn + F4) key combination, or press the power button if no LEDs are lit.</td>
</tr>
<tr>
<td>The system never goes into a power saving mode.</td>
<td>Power Options features are not enabled. Go to the Windows Power Options menu and enable the features you prefer (see “Power-Saving States” on page 3 - 6/“System Power Options” on page D - 17). Make sure you have enabled Hibernate mode from the control panel.</td>
</tr>
<tr>
<td>The Wireless LAN/Bluetooth/PC Camera modules cannot be detected.</td>
<td>The modules are off. Check the Wireless LED indicator to see if either the WLAN or Bluetooth modules are on or off (see “LED Indicators” on page 1 - 7). If the LED indicator is off, then press the appropriate function key combination in order to enable the modules. The function key indicators (see “Function/Hot Key Indicators” on page 1 - 9) will also indicate the power status of the modules.</td>
</tr>
<tr>
<td>The Wireless LAN/PC Camera modules cannot be configured.</td>
<td>The driver(s) for the module(s) have not been installed. Make sure you have installed the driver for the appropriate module (see the instructions in Chapter 7 “Modules” for the appropriate module).</td>
</tr>
<tr>
<td>The PC Camera software displays a black screen when the PC Camera software is run.</td>
<td>The software is using the incorrect device. If you have both an optional PC Camera and an optional TV Tuner module present, you will need to select which device to use with the BisonCap program. Go to the Devices menu in the BisonCap program and select the BisonCam, NB Pro device.</td>
</tr>
</tbody>
</table>

8 - 10 Problems & Possible Solutions
<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nothing appears on the screen when the PC Camera software is run.</td>
<td>You have selected an external display as the default display device. The PC Camera application software needs to be run while the <strong>default notebook LCD</strong> is the selected display device. After a camera picture is obtained on the default notebook LCD, you may then use the <strong>Fn + F7</strong> to toggle through the display modes (give the screen time to refresh). If you have selected an external display as your display device, do not run the PC Camera software until you have switched back to the notebook LCD.</td>
</tr>
<tr>
<td>A file cannot be copied to/from a connected Bluetooth device.</td>
<td>The transfer of data between the computer and a Bluetooth enabled device is supported <strong>in one direction only (simultaneous data transfer is not supported)</strong>. If you are copying a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from the Bluetooth enabled device to your computer until the file transfer process from the computer has been completed.</td>
</tr>
<tr>
<td>The Bluetooth module is off after resuming from Sleep.</td>
<td>The Bluetooth module’s default state will be <strong>off after resuming from the Sleep power-saving state</strong>. Use the key combination (<strong>Fn + F12</strong>) to power on the Bluetooth module after the computer resumes from Sleep.</td>
</tr>
<tr>
<td>No sound can be heard through an HDMI connected display device.</td>
<td>You have not configured the HDMI audio output. See “<strong>HDMI Audio Configuration</strong>” on page <strong>B-7</strong>.</td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <strong>Hibernate</strong> function has disappeared.</td>
<td><strong>You have a computer with 4GB of RAM and have installed Windows Vista Service Pack 1.</strong> This is a known issue if your computer has 4GB of RAM and is running Windows Vista Service Pack 1. To re-enable <strong>Hibernate</strong> mode go to the <strong>Command Prompt</strong> and type the command &quot;<strong>powercfg -h on</strong>&quot; (make sure you are logged on as an Administrator):</td>
</tr>
</tbody>
</table>
|                                                                        | 1. Click **Start** (menu button).  
2. Type "**cmd**" in the **Start Search** box.  
3. Double click the **Command Prompt** when it appears in the menu.  
4. Type "**powercfg -h on**" in the Command Prompt window.  
5. Close the Command Prompt window.  
6. The **Hibernate** function will now be enabled.                                                                 |
| The **3D Mark 2006** application exits or causes a "Blue Screen" when I attempt to run it. | **This is an known issue acknowledged by 3D Mark** (see [http://www.futuremark.com/support/3dmark06/](http://www.futuremark.com/support/3dmark06/)).  
Try un-plugging any external USB/FireWire storage devices such as DVD-drives or external hard disks. Some network-attached storage devices may also cause this problem to appear, so unmounting all network drives might also help.  
You can also add "-nosysteminfo" at the end of the "Target:" field of 3DMark 2006's application shortcut to disable the SystemInfo from running when the benchmark is being launched. This should allow you to run all of the tests normally, but your results can't be submitted to the ORB if this option has been used to launch the benchmark. |
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>On some occasions the LCD will appear to flicker while running the 3D Mark 2006 in demo mode, or while playing games.</td>
<td><em>This is an known issue acknowledged by NVIDIA which can arise when using NVIDIA chipsets with DirectX 10.0. Check the NVIDIA website for the latest updated drivers and current information.</em></td>
</tr>
<tr>
<td>The audio recording quality is poor.</td>
<td><em>The audio recording settings have not been set to the optimal quality.</em> Go to the Realtek HD Audio Manager and select Noise Suppression in Microphone (Microphone Effects). See “Setup for Audio Recording” on page 2 - 10 for more details.*</td>
</tr>
<tr>
<td>A “Blue Screen” appears at startup.</td>
<td><em>The BIOS setting has been set for the incorrect operating system.</em> Make sure that you have set the correct operating system appropriate for your system. See “Installed O/S (Advanced Menu)” on page 5 - 8 for more details.*</td>
</tr>
</tbody>
</table>
Troubleshooting

Screen Resolution Error

If you are experiencing either screen resolution reduction, or screen flickering after resuming from Sleep in Windows Vista only then follow the instructions below to fix this problem. This error arises in compliance with Windows Vista policy, which triggers TMM (Transient Multi-Monitor Manager) when the notebook lid (S3) is closed. TMM disconnects the LCD display from the OS and then adds the LCD display back when the lid is opened. This may trigger TMM to restore an old display setting which may result in screen flickering or a screen resolution change. To fix this problem you will need to disable TMM in the OS:

1. Go to the Control Panel in the Windows OS and double-click the Administrative Tools icon (System and Maintenance).
2. Double-click Task Scheduler (Schedule Tasks).

![Control Panel System and Maintenance](image)

Figure 8-1 - Control Panel System and Maintenance
3. Double-click **Task Scheduler Library > Microsoft > Windows**.
4. Click **MobilePC** to open the control panel.
5. Right-click **TMM** and select **Disable**.

![Figure 8 - 2 - TMM Disable](image)

6. Close all the control panels.
Appendix A: Interface (Ports & Jacks)

Overview

The following chapter will give a quick description of the ports & jacks which allow your computer to communicate with external devices, connect to the internet etc.
## Interface (Ports & Jacks)

### Ports and Jacks

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| Card Reader              | The card reader allows you to use the following digital storage cards:  
  MMC (MultiMedia Card)   | RS MMC (requires PC adapter)  
  SD (Secure Digital)      | Mini SD (requires PC adapter)  
  MS (Memory Stick)        | MS Duo (requires PC adapter)  
  MS (Memory Stick Pro)    |                                                                                                                                           |
| CATV Antenna Jack        | Use this jack to connect a CATV cable if you have included the **optional** Mini-PCI TV Tuner in your purchase.                                |
| Consumer Infrared        | The consumer infrared transceiver at the front of the computer allows the computer to communicate with the remote control unit supplied with the **optional** Mini-PCI TV Tuner (see “System Map: Bottom View” on page 1 - 13). |
| DC-In Jack               | Plug the supplied AC/DC adapter into this jack to power your computer.                                                                       |
| DVI-Out Port             | The DVI-Out (**Digital Visual Interface**) Port is a video connector interface. This allows you to connect an external monitor, TV or Flat Panel Display etc. as a display device (see “Attaching Other Displays” on page B - 5) by means of a DVI cable. If you are using an older type of monitor you will need to use a converter to convert the signal from DVI to VGA. |
### Interface (Ports & Jacks)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>e-SATA/USB Port</strong></td>
<td>This is a combined e-SATA (external Serial Advanced Technology Attachment)/ USB 2.0 compatible port.</td>
</tr>
<tr>
<td><strong>e-SATA</strong></td>
<td>Plug external Serial ATA hard drives into this e-SATA (external Serial Advanced Technology Attachment) port. See “USB 2.0/1.1 Ports” on page A - 5 for USB port information.</td>
</tr>
<tr>
<td></td>
<td>Not: The eSATA port only supports hot-swapping if you have selected AHCI mode in SATA Mode Selection in the BIOS (see “SATA Mode &amp; eSata Port” on page 5 - 8). If you have selected IDE mode, then hot-swapping devices connected to the eSATA port is not supported.</td>
</tr>
<tr>
<td></td>
<td>Note that hot-swapping is NOT supported in the Windows XP O/S.</td>
</tr>
<tr>
<td><strong>HDMI-Out Port</strong></td>
<td>The HDMI-Out (High-Definition Multimedia Interface) is an audio/video connector interface for transmitting uncompressed digital streams. This allows you to connect an external monitor, TV or Flat Panel Display etc. as a display device (see “Attaching Other Displays” on page B - 5) by means of a HDMI cable. Note that HDMI carries both audio and video signals.</td>
</tr>
<tr>
<td><strong>HDMI</strong></td>
<td>Note the HDMI configuration for audio output (see “HDMI Audio Configuration” on page B - 7).</td>
</tr>
<tr>
<td><strong>Headphone-Out Jack</strong></td>
<td>Headphones or speakers may be connected through this jack. Note: Set your system’s volume to a reduced level before connecting to this jack.</td>
</tr>
<tr>
<td><strong>Infrared (FIR) Transceiver</strong></td>
<td>The FIR (fast infrared) transceiver at the front of the computer allows the computer to communicate with similarly equipped devices e.g. the remote control unit supplied with the TV tuner device.</td>
</tr>
</tbody>
</table>
### Interface (Ports & Jacks)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line-In Jack</td>
<td>The Line-In jack allows you to play audio sources through the computer’s speakers.</td>
</tr>
<tr>
<td>Microphone-In Jack</td>
<td>Plug an external microphone in to this jack to record on your computer.</td>
</tr>
<tr>
<td>Mini-IEEE 1394 Port</td>
<td>This allows high-speed connection to various peripheral devices, e.g. external disk drives and digital cameras (see note below).</td>
</tr>
<tr>
<td><strong>IEEE 1394</strong></td>
<td>The Mini-IEEE 1394 ports only support SELF POWERED IEEE 1394 devices.</td>
</tr>
<tr>
<td>RJ-11 Phone Jack</td>
<td>This port connects to the built-in modem. You may plug the telephone line directly into this RJ-11 telephone connection.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Broadband (e.g. ADSL) modems usually connect to the LAN port.</td>
</tr>
<tr>
<td>RJ-45 LAN Jack</td>
<td>This port supports LAN (Network) functions.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Broadband (e.g. ADSL) modems usually connect to the LAN port.</td>
</tr>
</tbody>
</table>
## Interface (Ports & Jacks)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>S/PDIF-Out Jack</td>
<td>This S/PDIF (Sony/Philips Digital Interface Format) Out Port allows you to connect your DVD-capable PC to a Dolby AC-3 compatible receiver for “5.1” or ‘dts’ surround sound.</td>
</tr>
<tr>
<td>Security Lock Slot</td>
<td>To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be purchased at any computer store.</td>
</tr>
<tr>
<td>USB 2.0/1.1 Ports</td>
<td>These USB (Universal Serial Bus) 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into the computer, and unplugged from the computer, without the need to turn the system off (if the power rating of your USB device is 500mA or above, make sure you use the power supply which comes with the device).</td>
</tr>
</tbody>
</table>
Interface (Ports & Jacks)
Appendix B: NVIDIA Video Driver Controls

The basic settings for configuring the LCD are outlined in “Video Features” on page 1 - 15.

NVIDIA Video Driver Installation

Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3.

1. Insert the Device Drivers & Utilities + User’s Manual disc and click Install Drivers (button).
2. Click 2. Install Video Driver > Yes.
3. Click Next.
4. Click Finish to restart the computer.

Video Card Options

Note that card types, specifications and drivers are subject to continual updates and changes. Check with your service center for the latest details on video cards supported.

Resolution Error

If you are experiencing screen resolution problems/screen flickering after resuming from Sleep in Windows Vista see page 8 - 14.
NVIDIA Video Driver Controls

NVIDIA Control Panel

More advanced video configuration options are provided in the NVIDIA Control Panel tab.

1. Open the Display Settings (see page 1 - 16) control panel.
2. Click Advanced Settings (button).
3. Click GeForce..... (tab).
4. Click Start the NVIDIA Control Panel to make any video adjustments.

OR

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click NVIDIA Control Panel (click "Classic View" from the left of the menu if you are in Control Panel Home).

Figure B - 1
NVIDIA GeForce Control Panel
The **NVIDIA Control Panel** provides additional video configuration controls and tools which allow quick access to features such as display configuration, 3D Settings and Help menus etc.

**Navigating the Control Panel**

Navigate through the control panels in much the same way as you would a web page. Click on the sub-heading tasks in the left menu (and on the highlighted links) for information. Use the buttons on the top left to go back, forward etc.

*Figure B - 2
NVIDIA Control Panels*
The Help menus provide index and search features, and direct links to the NVIDIA website etc.

Figure B - 3
Help Menus
Attaching Other Displays

Note that you can use a DVI cable connected to the DVI-Out port, or an HDMI (High-Definition Multimedia Interface) cable connected to the HDMI-Out port to connect an external display (if you are using an older type of monitor you can use a converter to convert the signal from DVI to VGA). See your display device manual to see which formats are supported.

Configuring an External Display in Windows Vista

1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. If a New Display Detected window does not appear in Windows Vista, go to the Windows Mobility Center control panel (Mobile PC > Adjust commonly used mobility settings) and click Connect display.
3. Click on any of the buttons to configure the displays to your preferences, or click Display Settings (in the New Display Detected window) to access the control panel.

Display Devices

Besides the built-in LCD, you can also use an external monitor/flat panel display as your display device. The following are the display options:

- The built-in LCD.
- An external display connected to the DVI-Out port.
- An external display connected to the HDMI-Out port.

Note that HDMI supports video and audio signals.

Figure B - 4
New Display Detected
Configuring an External Display using the NVIDIA Control Panel
Alternatively you can use the **NVIDIA control panel** to configure any attached displays.

1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Go to **NVIDIA Control Panel** (see “NVIDIA Control Panel” on page B - 2).
3. Click **Display**, and then click **Set up multiple displays**.
4. Click to select the **nView display mode** you wish to use (see page B - 9).
5. Select the display(s) you want to use (if your display is not shown click "**My Display is not shown in the list...**" or use the **Fn + F7** key combination), and choose which display is to be the primary display.
6. Click **Apply > Yes** to save the changes.
HDMI Audio Configuration
As HDMI (High-Definition Multimedia Interface) carries both audio and video signals you will need to configure the audio output as per the instructions below.

Windows Audio Setup for HDMI
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound (Hardware and Sound).
3. Click Playback (tab), and click to select Realtek Digital Output.
4. Click Set Default (button).
5. Click OK to close the Sound control panel.
6. You will now be able to hear audio sources when played in Windows Media Player.

Click the taskbar volume indicator when Realtek Digital Output is selected, and you will note that the icon at the top of the volume level indicator has changed.
HDMI Notes

- Connect a device with HDMI support to the HDMI-Out port **BEFORE** attempting to play audio/video sources through the device.
- If you disconnect the HDMI cable the default audio playback device will not revert to speakers until the computer is restarted (if you do not wish to restart the computer then go to the **Sound** control panel and select **Speakers** as the default audio playback device).

HDMI Video Configuration

1. Connect an HDMI cable from the HDMI-Out port to your external display.
2. Configure your external display as per the instructions in “**Configuring an External Display using the NVIDIA Control Panel**” on page B - 6.
3. Set up your external display (TV or LCD) for HDMI input (see your display device manual).
4. You can now play video/audio sources through your external display.
Display Modes

Single Display Mode
Only one of your displays is used.

Clone Mode
Clone Mode simply shows an exact copy of the Primary display desktop on the other display(s). This mode will drive multiple displays with the same content.

Dualview Mode
Dualview Mode treats both connected displays as separate devices, and they act as a virtual desktop resulting in a large workspace. When Dualview is enabled, you can drag any icons or windows across to the other display desktop. It is therefore possible to have one program visible in one of the displays, and a different program visible in the other display.
Using New Display Detected to Enable Extended Mode
1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. If a New Display Detected window does not appear in Windows Vista, go to the Windows Mobility Center control panel (Mobile PC > Adjust commonly used mobility settings) and click Connect display.
3. Click to select Show different parts of my desktop on each display (extended).
4. Click Right or Left under Extend your desktop.
5. Click Apply > OK.

Figure B - 7
New Display Detected (Extended)
Using Display Settings to Enable Extended Mode

1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Click **Start**, and click **Control Panel** (or point to **Settings** and click **Control Panel**).
3. Click **Adjust screen resolution** under the **Appearance and Personalization** menu (or double-click **Personalization > Display Settings**).
4. Click the monitor icon (e.g. 2), and make sure you have checked “**Extend the desktop onto this monitor.**” and click **Apply**.

Click the appropriate monitor icon (e.g. 2) to be able to select the option to extend the desktop on to it.

In this example the Primary monitor 1 is on the left, the secondary display 2 is on the right.

Figure B - 8
Display Settings
(Extend the Desktop)

Display Settings
Extended Desktop

Use the control panel to drag the monitors to match the physical arrangement you wish to use.

You can drag any icons or windows across to either display desktop, which makes it possible to have one program visible in one of the displays, and a different program visible in the other display.
Enabling TV Display

To display desktop images on a TV, connect the TV to your computer by using an HDMI cable/DVI cable from the TV to the HDMI-Out port/DVI-Out port at the rear of the computer.

You will need to enable the TV display from the NVIDIA Control Panel as per the instructions on B - 5. The TV will appear as a display option (2. Select the displays you would like to use.) when attached to the HDMI-Out port/DVI-Out port. Apply the settings, and then click Yes to save the changes.
Changing the TV Signal Format

1. When the TV is enabled as a display device, click the sub-menus under Video & Television.
2. Click “Change the signal or HD format”.
3. Select the TV signal format (the menu allows you to select TV format by country if you are unsure of your TV format).
4. Apply the settings, and then click Yes to save the changes.

Figure B - 10
Change the Signal or HD Format
Appendix C: Specifications

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer's release schedule. Check with your service center for details.
## Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Processor Types</strong></td>
<td></td>
</tr>
<tr>
<td>Intel® Core™2 Duo Processor (478-pin) Micro-FC-PGA Package, Socket P P8400 / P8600</td>
<td>45nm (45 Nanometer) Process Technology 3MB On-die L2 Cache &amp; 1066MHz FSB, TDP 25W 2.26GHz / 2.4GHz</td>
</tr>
<tr>
<td>Intel® Core™2 Extreme Mobile Processor (478-pin) Micro-FC-PGA Package, Socket P X9100</td>
<td>45nm (45 Nanometer) Process Technology 6MB On-die L2 Cache, 44W &amp; 1066MHz FSB, TDP 44W 3.06GHz</td>
</tr>
<tr>
<td><strong>Core Logic</strong></td>
<td>Intel(R) PM45 + ICH9M Chipset</td>
</tr>
<tr>
<td><strong>LCD</strong></td>
<td>Flat Panel TFT (For <strong>One</strong> of the Following Options)</td>
</tr>
<tr>
<td></td>
<td>17&quot; WXGA (1440 * 900) TFT LCD (Glare Type or Non Glare Type)</td>
</tr>
<tr>
<td></td>
<td><strong>OR</strong></td>
</tr>
<tr>
<td></td>
<td>17&quot; WXUGA (1920 * 1200) TFT LCD (Glare Type)</td>
</tr>
</tbody>
</table>
## Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Security</strong></td>
<td>Security (Kensington® Type) Lock Slot</td>
</tr>
<tr>
<td></td>
<td>BIOS Password</td>
</tr>
<tr>
<td></td>
<td>Fingerprint Reader Module (Factory Option)</td>
</tr>
<tr>
<td><strong>Memory</strong></td>
<td>Two 204 Pin SO-DIMM Sockets Supporting DDRIII (DDR3) at 800 MHz / 1066 MHz</td>
</tr>
<tr>
<td></td>
<td>Supports Dual Channel DDRIII (DDR3) SDRAM</td>
</tr>
<tr>
<td></td>
<td>64-bit Wide Per Data Channel</td>
</tr>
<tr>
<td></td>
<td>Memory Expandable up to 4GB (1024/ 2048 MB DDRIII Modules)</td>
</tr>
<tr>
<td><strong>Video Adapter Options</strong></td>
<td>NVIDIA GeForce 9800M-GTX</td>
</tr>
<tr>
<td></td>
<td>NB9E-GTX Modular</td>
</tr>
<tr>
<td></td>
<td>512MB DDR3 Video RAM On Board</td>
</tr>
<tr>
<td></td>
<td>Supports PCI-Express * 16</td>
</tr>
<tr>
<td></td>
<td>MS DirectX® 10.0 compatible</td>
</tr>
<tr>
<td></td>
<td>MXM-IV</td>
</tr>
<tr>
<td></td>
<td>Supports HDCP</td>
</tr>
<tr>
<td></td>
<td>NVIDIA GeForce 8800M-GTX</td>
</tr>
<tr>
<td></td>
<td>NB8E-GTX Modular</td>
</tr>
<tr>
<td></td>
<td>512MB DDR3 Video RAM On Board</td>
</tr>
<tr>
<td></td>
<td>Supports PCI-Express * 16</td>
</tr>
<tr>
<td></td>
<td>MS DirectX® 10.0 compatible</td>
</tr>
<tr>
<td></td>
<td>MXM-IV</td>
</tr>
<tr>
<td></td>
<td>Supports HDCP</td>
</tr>
</tbody>
</table>

### Video Card Options

Note that card types, specifications and drivers are subject to continual updates and changes. Check with your service center for the latest details on video cards supported.

<table>
<thead>
<tr>
<th>BIOS</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>One 2M/4M Bytes Flash ROM</td>
</tr>
<tr>
<td></td>
<td>Phoenix™ BIOS</td>
</tr>
</tbody>
</table>
## Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Storage</strong></td>
<td>One Changeable 12.7mm(h) SATA Optical Device (CD/DVD) Type Drive (see “Optional” on page C-6 for drive options)</td>
</tr>
<tr>
<td></td>
<td>Easy Changeable 2.5&quot; 9.5 mm (h) SATA (Serial) HDD</td>
</tr>
<tr>
<td><strong>Card Reader</strong></td>
<td>Embedded 7-in-1 Card Reader (MS/ MS Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS Duo)</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: MS Duo/ Mini SD/ RS MMC Cards Require a PC Adapter</td>
</tr>
<tr>
<td><strong>Audio</strong></td>
<td>Integrated AZALIA Compliant Interface</td>
</tr>
<tr>
<td></td>
<td>Intel® High Definition Audio</td>
</tr>
<tr>
<td></td>
<td>3D Stereo Enhanced Sound System</td>
</tr>
<tr>
<td></td>
<td>SRS <strong>WOW</strong> Surround Sound Technology</td>
</tr>
<tr>
<td></td>
<td>Sound-Blaster PRO™ Compatible</td>
</tr>
<tr>
<td></td>
<td>S/PDIF Digital Output</td>
</tr>
<tr>
<td></td>
<td>Built-In Microphone</td>
</tr>
<tr>
<td></td>
<td>2 * Built-In Speakers (1.5W, 8Ω)</td>
</tr>
<tr>
<td></td>
<td>One Sub Woofer (2W, 8Ω)</td>
</tr>
<tr>
<td></td>
<td>5.1 Channel Support</td>
</tr>
<tr>
<td><strong>Keyboard &amp; Pointing Device</strong></td>
<td>Full Size Winkey Keyboard with Numeric Keypad</td>
</tr>
<tr>
<td></td>
<td>Built-In TouchPad (Scroll Functionality Included)</td>
</tr>
<tr>
<td><strong>ExpressCard Slot</strong></td>
<td>ExpressCard/34/54 Slot</td>
</tr>
<tr>
<td><strong>Mini-Card Slots</strong></td>
<td>One Mini-Card Slot for <strong>Wireless LAN Module</strong></td>
</tr>
<tr>
<td></td>
<td>One Mini-Card Slot for <strong>TV Tuner Module</strong></td>
</tr>
</tbody>
</table>
## Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>I/O Ports</strong></td>
<td></td>
</tr>
<tr>
<td>Four USB 2.0 Ports</td>
<td>One Mini-IEEE1394a Port</td>
</tr>
<tr>
<td>One eSATA Port (eSATA/USB Port Combined)</td>
<td>One RJ-11 Modem Jack</td>
</tr>
<tr>
<td>eSATA supported in Windows Vista only:</td>
<td>One RJ-45 Gigabit LAN Jack</td>
</tr>
<tr>
<td>AHCI mode supports hot swapping</td>
<td>One DC-In Jack</td>
</tr>
<tr>
<td>IDE mode does not support hot swapping</td>
<td>One Infrared Transceiver</td>
</tr>
<tr>
<td>One eSATA Port</td>
<td>One Cable (CATV) Antenna (Analog/Digital) Jack (Functions with Optional USB TV Tuner Module)</td>
</tr>
<tr>
<td>One HDMI-Out (High-Definition Multimedia Interface) Port (supports 5.1 channel) with audio output</td>
<td>One Consumer Infrared Transceiver (Functions with Optional USB TV Tuner Module)</td>
</tr>
<tr>
<td>One DVI-Out Port</td>
<td></td>
</tr>
<tr>
<td>One Headphone/Speaker-Out Jack</td>
<td></td>
</tr>
<tr>
<td>One Microphone-In Jack</td>
<td></td>
</tr>
<tr>
<td>One S/PDIF Out Jack</td>
<td></td>
</tr>
<tr>
<td>One Line-In Jack for Audio Input</td>
<td></td>
</tr>
<tr>
<td>One Mini-IEEE1394a Port</td>
<td>One RJ-11 Modem Jack</td>
</tr>
<tr>
<td>One RJ-45 Gigabit LAN Jack</td>
<td>One DC-In Jack</td>
</tr>
<tr>
<td>One Infrared Transceiver</td>
<td>One Cable (CATV) Antenna (Analog/Digital) Jack (Functions with Optional USB TV Tuner Module)</td>
</tr>
<tr>
<td>One Consumer Infrared Transceiver (Functions with Optional USB TV Tuner Module)</td>
<td>One DC-In Jack</td>
</tr>
<tr>
<td><strong>Communication</strong></td>
<td>Wireless LAN Module:</td>
</tr>
<tr>
<td>Built-In 56K MDC Modem, V.90 &amp; V.92 Compliant</td>
<td>Intel® WiFi Link 5300 Series (3*3 - 802.11a/g/n)</td>
</tr>
<tr>
<td>Built-In Giga Base TX Ethernet LAN</td>
<td>Wireless LAN Mini-Card Module (Option)</td>
</tr>
<tr>
<td>Bluetooth 2.0 + EDR (Enhanced Data Rate) Module (Factory Option)</td>
<td>Intel® WiFi Link 5100 Series (1*2 - 802.11a/g/n)</td>
</tr>
<tr>
<td><strong>Operating Systems Supported</strong></td>
<td>Wireless LAN Mini-Card Module (Option)</td>
</tr>
<tr>
<td>Windows XP SP2</td>
<td>Windows Vista 64bit SP1</td>
</tr>
<tr>
<td>Windows Vista 64bit SP1</td>
<td>Home Premium/ Business/ Enterprise/ Ultimate</td>
</tr>
</tbody>
</table>

*Optional*
## Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Power Management</strong></td>
<td>Supports ACPI 3.0&lt;br&gt;Supports Resume from Modem Ring&lt;br&gt;Supports Wake on LAN</td>
</tr>
<tr>
<td><strong>Power</strong></td>
<td>Full Range AC/DC Adapter – AC in 100 - 240V, 50 - 60Hz&lt;br&gt;DC Output 20V, 6A (120 Watts)&lt;br&gt;Easy Changeable 8-Cell Smart Lithium-Ion 4400mAh Main Battery</td>
</tr>
<tr>
<td><strong>Environmental Spec</strong></td>
<td><strong>Temperature</strong>&lt;br&gt;Operating: 5°C ~ 35°C&lt;br&gt;Non-Operating: -20°C ~ 60°C&lt;br&gt;<strong>Relative Humidity</strong>&lt;br&gt;Operating: 20% ~ 80%&lt;br&gt;Non-Operating: 10% ~ 90%</td>
</tr>
<tr>
<td><strong>Physical Dimensions &amp; Weight</strong></td>
<td>397mm (w) * 280.5mm (d) * 25.6 ~ 45.6mm (h)&lt;br&gt;Around 4kg (+/- 5%) with 8 Cell Battery</td>
</tr>
<tr>
<td><strong>Optional</strong></td>
<td><strong>Optical Drive Module Options:</strong>&lt;br&gt;Combo SATA Drive Module&lt;br&gt;DVD Dual (Super Multi) SATA Drive Module&lt;br&gt;Blu-Ray SATA Drive Module&lt;br&gt;<strong>Wireless LAN Module:</strong>&lt;br&gt;Intel® WiFi Link 5300/5100 Series (3<em>3/1</em>2 - 802.11a/g/n) Wireless LAN Mini-Card Module&lt;br&gt;TV Tuner Module with Mini-Card, USB Interface&lt;br&gt;1.3M or 2.0M Pixel USB 2.0 PC Camera Module (Factory Option)&lt;br&gt;Fingerprint Reader Module (Factory Option)&lt;br&gt;Bluetooth 2.0 + EDR (Enhanced Data Rate) Module (Factory Option)</td>
</tr>
</tbody>
</table>
Appendix D: Windows XP Information

This Appendix contains information (including control panel information, driver installation etc.) for users of the *Windows XP OS*. 
**DVD Regional Codes**

**Changing DVD Regional Codes**

Go to the Control Panel and double-click **System > Hardware** (tab), click **Device Manager**, then click the + next to DVD/CD-ROM drives. Double-click on the DVD-ROM device to bring up the Properties dialogue box, and select the **DVD Region** (tab) to bring up the control panel to allow you to adjust the regional code.

DVD region detection is device dependent, not OS-dependent. You can select your module’s region code 5 times. The fifth selection is permanent. This cannot be altered even if you change your operating system or you use the module in another computer.

<table>
<thead>
<tr>
<th>Region</th>
<th>Geographical Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>USA, Canada</td>
</tr>
<tr>
<td>2</td>
<td>Western Europe, Japan, South Africa, Middle East &amp; Egypt</td>
</tr>
<tr>
<td>3</td>
<td>South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, Hong Kong</td>
</tr>
<tr>
<td>4</td>
<td>South &amp; Central America, Mexico, Australia, New Zealand</td>
</tr>
<tr>
<td>5</td>
<td>N Korea, Russia, Eastern Europe, India &amp; Most of Africa</td>
</tr>
<tr>
<td>6</td>
<td>China</td>
</tr>
</tbody>
</table>

*Table D - 1 - DVD Region Codes*
Windows XP Start Menu & Control Panel

Most of the control panels, utilities and programs within *Windows XP* (and most other *Windows* versions) are accessed from the **Start** menu. When you install programs and utilities they will be installed on your hard disk drive, and a shortcut will usually be placed in the **Start** menu and/or the desktop. You can customize the look of the **Start** menu by right-clicking the **Start** menu and selecting **Properties** from the menu.

In many instances throughout this manual you will see an instruction to open the **Control Panel**. The **Control Panel** is accessed from the **Start** menu, and it allows you to configure the settings for most of the key features in *Windows* (e.g. power, video, network, audio etc.). *Windows XP* provides basic controls for many of the features, however many new controls are added (or existing ones are enhanced) when you install the drivers. To see all controls it may be necessary to toggle off Category View.

*Figure D - 2* - Start Menu & Control Panel
Audio Features

You can configure the audio options on your computer from the Sounds and Audio Devices control panel in Windows. For advanced options, double-click the Realtek HD Audio Manager icon in the taskbar (or click the control panel) to bring up the Realtek Audio Configuration menus. The volume may also be adjusted by means of the Fn + F5/F6 key combination.

Figure D - 3
Realtek Audio Configuration Menus
Function/Hot Key Indicators

The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition to the basic function key combinations; visual indicators (see the table below) are available when the hot key utility is installed (see “Hot Key” on page D - 28). After installing the driver an icon \[\text{\textbullet} \] will appear in the taskbar.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fn + ~</td>
<td>Play/Pause (in Audio/Video Programs)</td>
<td>Fn + F8/F9</td>
<td>Brightness Decrease/Increase</td>
</tr>
<tr>
<td>Fn + F1</td>
<td>TouchPad Toggle</td>
<td>Fn + F10</td>
<td>PC Camera Power Toggle</td>
</tr>
<tr>
<td>Fn + F2</td>
<td>Turn LCD Backlight Off (Press a key to or use TouchPad to turn on)</td>
<td>Fn + F11</td>
<td>WLAN Module Power Toggle</td>
</tr>
<tr>
<td>Fn + F3</td>
<td>Mute Toggle</td>
<td>Fn + F12</td>
<td>Bluetooth Module Power Toggle</td>
</tr>
<tr>
<td>Fn + F4</td>
<td>Sleep Toggle</td>
<td>Fn + Scr Lk</td>
<td>Scroll Lock Toggle</td>
</tr>
<tr>
<td>Fn + F5/F6</td>
<td>Volume Decrease/Increase</td>
<td></td>
<td>*Silent Mode Toggle</td>
</tr>
<tr>
<td>Fn + F7</td>
<td>Display Toggle</td>
<td></td>
<td>*When enabled, Silent Mode will reduce fan noise and save power consumption. Note this may reduce computer performance.</td>
</tr>
</tbody>
</table>

Table D - 2 - Function/Hot Key Combo Indicators
Video Features

You can switch display devices, and configure display options, from the Display Properties control panel in Windows as long as the appropriate video driver is installed.

To access Display Properties in Windows:

1. Click Start, point to Settings and click Control Panel (or just click Control Panel).
2. Double-click Display (icon) - In the Appearances and Themes category.
3. Click Settings (tab) in the Display Properties dialog box.
4. Move the slider to the preferred setting in Screen resolution
5. Click the arrow, and scroll to the preferred setting in Color quality
6. You can also access Display Properties by right-clicking the desktop and scrolling down and clicking Properties. Click Settings (tab) and adjust as above.
7. Open the Display Properties control panel, and click Advanced (button) to bring up the Advanced properties tabs.
8. Click GeForce..... (tab).
9. Click Start the NVIDIA Control Panel (Figure D - 4 on page D - 7) to access the control panel.
10. The NVIDIA Control Panel can also be accessed by right-clicking the desktop, and then clicking NVIDIA Control Panel (or from the NVIDIA Control Panel in the Windows control panel).
Display Properties & NVIDIA Control Panel

Figure D - 4 - Display Properties & NVIDIA Control Panel

Video Card Options

Note that card types, specifications and drivers are subject to continual updates and changes. Check with your service center for the latest details on video cards supported.
NVIDIA Video Driver Controls

Access the NVIDIA Control Panel as indicated on page D - 6. You may make changes to the video and display settings by clicking the appropriate menu item.

Navigating the Control Panel

Navigate through the control panels in much the same way as you would a web page. Click on the headings, menus and highlighted links for information. Use the buttons on the top left to go back, forward etc.

The Help menus provide index and search features, and direct links to the NVIDIA website etc.

Figure D - 5

NVIDIA Control Panels
The **Help** menus provide index and search features, and direct links to the NVIDIA website etc.

![Figure D - 6: Help Menus](image-url)
Display Devices and Modes (NVIDIA)
Note that you can use a DVI cable connected to the DVI-Out port, or an HDMI (High-Definition Multimedia Interface) cable connected to the HDMI-Out port to connect an external display (if you are using an older type of monitor you can use an adapter to convert the signal from DVI to VGA). See your display device manual to see which formats are supported.

<table>
<thead>
<tr>
<th>nView Display Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single</td>
<td>One of the connected displays is used as the display device</td>
</tr>
<tr>
<td>Clone</td>
<td>Both connected displays output the same view</td>
</tr>
<tr>
<td>Dualview</td>
<td>Both connected displays are treated as separate devices, may be configured independently and act as a virtual desktop (this is similar to Extended Desktop in Windows)</td>
</tr>
</tbody>
</table>

See “HDMI Audio Configuration” on page D - 14 for instructions on configuring audio when setting up an HDMI display as an external device.
Switching Displays

When using the **Fn + F7** key combination to toggle through the display options; give the displays time to refresh. The displays will toggle though in the order below (note that CRT refers to an older type of monitor connected to the DVI-Out port using an adapter):

- The built-in LCD only.
- An CRT connected to the DVI-Out port (using an adapter) only.
- An external display connected to the DVI-Out port only.
- An external display connected to the HDMI-Out port only.
- The built-in LCD and a CRT connected to the DVI-Out port (using an adapter).
- The built-in LCD and an external display connected to the DVI-Out port.
- The built-in LCD and an external display connected to the HDMI-Out port.
- A CRT connected to the DVI-Out port (using an adapter) and an external display connected to the HDMI-Out port.
- External displays connected to the DVI-Out and HDMI-Out ports.
- The built-in LCD only.
Attaching Other Displays
1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Go to the NVIDIA Control Panel.
3. Click Display, and then click Set up multiple displays.
4. Choose the nView display mode you wish to use.
5. Select the displays you want to use (if your display is not shown click “My Display is not shown in the list...” or use the Fn + F7 key combination), and choose which display is to be the primary display.
6. Click Apply.
To Enable Extended Desktop (Windows Display Properties)
1. Attach your external display to the external monitor port or HDMI-Out port, and turn it on.
2. Click Start, point to Settings (or click Control Panel) and click Control Panel (if you are in Category View choose Appearance and Themes).
3. Double-click Display (icon).
4. In the Display Properties dialog box, click Settings (tab).
5. Click the monitor icon (e.g. 2), and make sure you have checked “Extend my Windows desktop onto this monitor.” and click Apply.

Click the appropriate monitor icon (e.g. 2) to be able to select the option to extend the desktop on to it.

In this example the Primary monitor 1 is on the left, the secondary display 2 is on the right.

Figure D - 8 - Display Properties (Extended Desktop)
HDMI Audio Configuration

As HDMI (High-Definition Multimedia Interface) carries both audio and video signals you will need to configure the audio output as per the instructions below.

Windows Audio Setup for HDMI
1. Connect a device with HDMI support to the HDMI-Out port.
2. Go to the Start menu and point to Settings (or just click Control Panel) and click Control Panel, then double-click the Sounds & Audio Devices icon (Sounds, Speech, and Audio Devices in Category View).
3. Click Audio (tab).
4. Click Default device (Sound Playback) and select NVIDIA HDMI Audio.
5. Click OK to close the control panel (see overleaf).

Figure D - 9
Sounds and Audio Devices Properties
HDMI Video Configuration
1. Connect an HDMI cable from the HDMI-Out port to your external display.
2. Configure your external display as per the instructions in “Attaching Other Displays” on page D - 12.
3. Set up your external display (TV or LCD) for HDMI input (see your display device manual).
4. You can now play video/audio sources through your external display.

HDMI Note
• Connect a device with HDMI support to the HDMI-Out port **BEFORE** attempting to play audio/video sources through the device.

Other Applications
If you are using a third party application to play DVDs etc. you will need to consult the application’s documentation to see the appropriate audio configuration (the application must support digital to analog translation).
Power Management Features

The **Power Options** control panel icon in *Windows* (see page D - 3) allows you to configure power management features for your computer. You may conserve power through individual components such as the monitor or hard disk, or you may use either **Stand by** or **Hibernate** mode to conserve power throughout the system.

**Power Schemes**

You can set your computer to conserve power through individual components by means of **Power Schemes**. You can also adjust the settings for each scheme to set the monitor to turn off after a specified time, and the computer's hard disk motor to turn off if the hard disk drive has not been accessed for a specified period of time (if the system reads or writes data, the hard disk motor will be turned back on). The schemes may also be set to set a specified time for the system to enter **Stand by** or **Hibernate** modes.

![Power Schemes](image)

**Resuming Operation**

Press the **Sleep/Resume** key combination (Fn + F4), or power button to resume from Monitor or Hard Disk Stand by.

*Figure D - 10 - Power Schemes*
Each *Windows Power Scheme* will also adjust the processor performance of your machine in order to save power. This is worth bearing in mind if you are experiencing any reduced performance (especially under DC/battery power).

Choose the *Home/Office Desk* scheme for maximum performance when the computer is powered from an AC power source. Choose the *Max Battery* scheme (bear in mind that this scheme may slow down the overall performance of the computer in order to save power) for maximum power saving when the computer is battery (DC power) powered. *Windows* will use *Portable/Laptop* as the default scheme.

**System Power Options**

You can use the system power options to stop the computer’s operation and restart where you left off. This system features *Stand by* and *Hibernate* sleep mode levels (*Hibernate* mode will need to be enabled by clicking the option in the *Hibernate* tab in the *Power Options* control panel).

**Hibernate Mode vs. Shutdown**

Hibernate mode and Shutdown are the same in that the system is off and you need to press the power button to turn it on. When you come back from hibernation, you can return to where you last left off (what was on your desktop) without reopening the application(s) and file(s) you last used.

**Stand by Mode vs. Hibernate Mode**

If you want to stay away from your work for just a while, you can put the system on *Stand by* instead of in hibernation. It takes a longer time to wake up the system from *Hibernate* mode than from *Stand by* mode.
Windows XP Information

Stand by
Stand by saves the least amount of power, but takes the shortest time to return to full operation. During Stand by the hard disk is turned off, and the CPU is made to idle at its slowest speed. All open applications are retained in memory. When you are not using your computer for a certain length of time, which you specify in the operating system, it will enter Stand by mode to save power.

Hibernate
Hibernate uses no power and saves all of your information on a part of the HDD before it turns the system off. Although it saves the most power it takes the longest time to return to full operation. You can set your computer to automatically enter Hibernate mode when the battery power is almost depleted. You will need to enable Hibernate mode from the Hibernate tab in the Power Options control panel. The system will resume from Hibernate mode by pressing the power button.

System Resume
The system can resume from Stand by mode by:

• Pressing the power button
• An incoming call received on the modem (if enabled)
• Network card activity (if enabled)

Figure D - 11 - Enable Hibernation

D - 18 Power Management Features
Configuring the Power Button

The power button may be set to send the computer into either Stand by or Hibernate mode. In Stand by mode, the LED will blink green. In Hibernate mode the LED will be off (battery). If you are in a power saving mode set to save power through individual components (e.g. hard disk, monitor), the LED will remain green.

**Figure D - 12 - Power Options (Advanced - Power Buttons)**
Battery Information

Please follow these simple guidelines to get the best use out of your battery.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ” on page D - 23).

Battery Life
Your computer’s battery life is dependent upon many factors, including the programs you are running, and peripheral devices attached. Power Options (you may set low battery Alarms and actions, and check the Power Meter from the Power Options control panel), and settings in the OS will help prolong the battery life if configured appropriately.

Low Battery Warning
When the battery is critically low, immediately connect the AC/DC adapter to the computer or save your work, otherwise, the unsaved data will be lost when the power is depleted.

Figure D - 13 - Power Options (Alarm & Power Meter)
Battery life may be shortened through improper maintenance. **To optimize the life and improve its performance, fully discharge and recharge the battery at least once every 30 days.**

We recommend that you do not remove the battery yourself. If you do need to remove the battery for any reason see **“Removing the Battery” on page 6 - 3.**

**Recharging the Battery with the AC/DC Adapter**

The battery pack automatically recharges when the AC/DC adapter is attached and plugged into an electrical outlet. If the computer is powered on, and in use, it will take several hours to fully recharge the battery. When the computer is turned off but plugged into an electrical outlet, battery charge time is less. (Refer to **“LED Indicators” on page 1 - 7** for information on the battery charge status, and to **“Battery Information” on page D - 20** for more information on how to maintain and properly recharge the battery pack.)

---

**Conserving Battery Power**

To conserve battery power:

-- Lower the brightness level of the LCD display. The system will decrease LCD brightness slightly to save power when it is not powered by the AC/DC adapter.

-- Close modem or communication applications when they are not being used.

-- Remove any unused Express Cards from the computer (Express Cards quickly use up battery power even if the system enters sleep mode).

-- Disconnect any unnecessary external devices.
Windows XP Information

Proper handling of the Battery Pack

- DO NOT disassemble the battery pack under any circumstances
- DO NOT expose the battery to fire or high temperatures, it may explode
- DO NOT connect the metal terminals (+, -) to each other

Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being dropped), or any unusual smells emanating from the notebook battery, shut your computer down immediately and contact your service center. If the battery has been dropped we do not recommend using it any further, as even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire. It is recommended that you replace your computer battery every two years.
Battery FAQ

How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t turn off the computer by yourself even when you see a message that indicates the battery is critically low, just let the computer use up all of the battery power and shut down on its own. Disable the Power Options functions in the Control Panel, especially any Alarms (unclick the tickboxes - see page D - 20) and Schemes (change all the settings to Never - see page D - 16). As the battery nears the end of its life save and close any critical files.

How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges.

Caution

Danger of explosion if battery is incorrectly replaced.
Replace only with the same or equivalent type recommended by the manufacturer. Discard used battery according to the manufacturer’s instructions.
Driver Installation

Insert the Device Drivers & Utilities + User’s Manual disc and click Install Drivers (button), or Optional (button) to access the Optional driver menu.

If you wish to install the drivers manually see page “Manual Driver Installation” on page D - 25.

1. Check the driver installation order from Table D - 4, on page D - 25 (the drivers must be installed in this order) which is the same as that listed in the Drivers Installer menu below.
2. Click to select the driver you wish to install, after installing each driver it will become grayed out (if you need to reinstall any driver, click the Unlock button).
3. Follow the instructions for each individual driver installation procedure as listed on the following pages.

Figure D - 14 - Drivers Installer Screen 1

Figure D - 15 - Drivers Installer Screen 2
### Windows XP Information

#### Manual Driver Installation

Click the **Browse CD** button in the *Drivers Installer* application and browse to the executable file in the appropriate driver folder.

<table>
<thead>
<tr>
<th>WinXP SP2 Driver</th>
<th>Page #</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chipset</td>
<td>D - 27</td>
</tr>
<tr>
<td>Video</td>
<td>D - 27</td>
</tr>
<tr>
<td>Audio</td>
<td>D - 27</td>
</tr>
<tr>
<td>Modem</td>
<td>D - 27</td>
</tr>
<tr>
<td>LAN</td>
<td>D - 28</td>
</tr>
<tr>
<td>Card Reader/ExpressCard</td>
<td>D - 28</td>
</tr>
<tr>
<td>TouchPad</td>
<td>D - 28</td>
</tr>
<tr>
<td>Hot Key</td>
<td>D - 28</td>
</tr>
<tr>
<td>PC Camera Module</td>
<td>D - 34</td>
</tr>
<tr>
<td>WLAN Module</td>
<td>D - 41</td>
</tr>
<tr>
<td>Fingerprint Reader Module</td>
<td>D - 44</td>
</tr>
<tr>
<td>USB TV Tuner Module</td>
<td>D - 47</td>
</tr>
</tbody>
</table>

*Table D - 4 - Driver Installation*
Windows XP Information

Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it may be necessary to uninstall the original driver. To do this go to the Control Panel in the Windows OS and double-click the Add/Remove Programs item. If you see the individual driver listed (if not see below), uninstall it, following the on screen prompts (it may be necessary to restart the computer). Go to the appropriate section of the manual to complete the update/reinstall procedure for the driver in question.

If the driver is not listed in the Add/Remove Programs item:
1. Click Start (menu), point to Settings and click Control Panel (or click Start > Control Panel).
2. Double-click System (icon); System (icon) is in Performance and Maintenance (category).
3. Click Hardware (tab) > Device Manager (button).
4. Double-click the device you wish to update/reinstall the driver for (you may need to click “+”).
5. Look for the Update Driver button (check the Driver tab) and follow the on screen prompts.

Windows XP Service Pack 2
Make sure you install Windows XP Service Pack 2 (or a Windows XP version which includes Service Pack 2) before installing any drivers. Service Pack 2 includes support for USB 2.0.

If you have upgraded the system by installing Service Pack 2 (i.e. your Windows XP version does not include Service Pack 2) then follow these instructions:
1. Click Start (menu), point to Settings and click Control Panel (or click Control Panel).
2. Double-click System (icon); System (icon) is in Performance and Maintenance (category).
3. Click the Hardware (tab) > Device Manager (button).
4. Click “+” next to Other Devices (if its sub-items are not shown).
5. Right-click Universal Serial Bus (USB) Controller and select Uninstall > OK (if you don’t see the item then there is no need to take any further action).
6. Restart the computer and it will find the USB 2.0 controller.
Driver Installation Procedure
Insert the Device Drivers & Utilities + User’s Manual disc and click Install Drivers (button).

Found New Hardware Wizard
If you see the “Found New Hardware Wizard” during the installation procedure (other than when outlined in the driver install procedure), click Cancel to close the window, and follow the installation procedure.

Chipset
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

Video
1. Click 2.Install Video Driver > Yes.
2. Click Next.
3. Click “Yes, I want to restart my computer now” (button).
4. Click Finish to restart the computer.

Audio
1. Click 3. Install Audio Driver > Yes.
2. Click Next (click Cancel if a Found New Hardware Wizard appears).
3. Click Finish to restart the computer.

Modem
1. Click 4.Install Modem Driver > Yes.
2. Click OK.
3. The modem is now ready for configuration.

Modem Country Selection
Be sure to check if the modem country selection is appropriate for you (Control Panel > Phone and Modem Options).
Windows XP Information

LAN
1. Click 5. Install LAN Driver > Yes.
2. Click Next > Install.
3. Click Finish.
4. The network settings can now be configured.

Card Reader/ExpressCard
1. Click 6. Install Cardreader Driver > Yes.
2. Click Next > Install.
3. Click Finish.

TouchPad
1. Click 7. Install Touchpad Driver > Yes.
2. Click Next > Next > Next.
3. Click Finish to restart the computer.

Hot Key
1. Click 8. Install Hotkey Driver > Yes.
2. Click Next > Install.
3. Click Finish > Finish to restart the computer.

Module Drivers
See the following pages for the driver installation procedures for any of the optional modules included in your purchase configuration.

Bluetooth & Wireless LAN Modules

Wireless Device Operation Aboard Aircraft
The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.

Power Toggle for the Wireless LAN and Bluetooth Modules
Enable power to the modules as follows:
Fn + F11 = Wireless LAN Module Power Toggle
Fn + F12 = Bluetooth Module Power Toggle

When the WLAN module is on, the (WiFi) LED will be green.
When the Bluetooth module is on, the (Bluetooth) LED will be orange.
Bluetooth Module

The operating system’s Bluetooth Devices control panel is used to configure the Bluetooth settings in Windows XP, and therefore does not require a driver. Use the Fn + F12 key combination (see “Function/Hot Key Indicators” on page D - 5) to toggle power to the Bluetooth module.

Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is supported in one direction only (simultaneous data transfer is not supported). Therefore if you are copying a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from the Bluetooth enabled device to your computer until the file transfer process from the computer has been completed.

Bluetooth Module & Resuming From Sleep Mode

The Bluetooth module’s default state will be off after resuming from the Sleep power-saving state. Use the key combination (Fn + F12) to power on the Bluetooth module after the computer resumes from Sleep.
Bluetooth Local Area Connection Icon
If you want to display the Local Area Connection icon for the Bluetooth connection in the taskbar, set it up as follows:

1. Access the Network Connections control panel in Windows (Start > Settings > Network Connections OR Start > Connect To > Show all Connections) or by clicking the taskbar icon.
2. Right-click the Bluetooth connection icon, and select Properties.
3. Click to put a tick (if none is present) in the "Show icon in the notification area when connected" box and click OK.
4. Close the control panels and the icon for the Bluetooth local area connection will be displayed in the taskbar when connected (see sidebar and overleaf).
Bluetooth Configuration in Windows XP

Setup your Bluetooth Device so the Computer Can Find it
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
2. Make the device discoverable (to do this check your device documentation).

To Turn the Bluetooth Module On
1. Press the **Fn + F12** key combination to power on the Bluetooth module.
2. A Bluetooth icon will appear in the taskbar (see sidebar).
3. You can then do any of the following to access the **Bluetooth Devices** control panel.
   - **Double-click** the icon to access the **Bluetooth Devices** control panel.
   - **Click Start**, and click **Control Panel** (or point to **Settings** and click **Control Panel**), and then click **Bluetooth Devices** (Network and Internet Connections).
   - **Click/Right-click** the icon and choose an option from the menu.

![Bluetooth Taskbar Icon](image)

If you cannot see the Bluetooth icon in the taskbar, access the **Bluetooth Devices** control panel. **Click Options** (tab), and make sure that **Show Bluetooth icon in the notification area** check box has a tick inside it.

Note that you will need to check the LED indicator to see if the module is powered on or not.

![Figure D - 17 Bluetooth Devices & Click Icon Menu](image)
To Add a Bluetooth Device

1. Access the Bluetooth Devices control panel.
2. Click Options (tab), and make sure that Allow Bluetooth devices to connect to this computer check box (Connections) has a tick inside it.
3. Click Devices (tab), and then click Add.
5. Click to select "My device is set up and ready to be found", and then click Next.
6. The Wizard will then search for any available Bluetooth devices within range.
7. Click to select the device you want to communicate with, and click Next.
8. Select an appropriate passkey option and click Next.
9. Click Finish.
To Change Settings for the Bluetooth Device
1. Access the Bluetooth Devices control panel.
2. Click on the device you want to change and click Properties to:
   • Change the name of the device (click General, type a new name and click OK).
   • Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

To Make your Computer Discoverable to Bluetooth Devices
1. Access the Bluetooth Devices control panel.
2. Click Options, and make sure that Turn discovery on check box (Discovery) has a tick inside it.
3. Make sure that Alert me when a new Bluetooth device wants to connect check box (Connections) has a tick inside it, if you want to be notified when a Bluetooth device wants to connect.

Figure D - 20
Bluetooth Devices Options
PC Camera Module

Before installing the optional PC Camera module driver use the \textbf{Fn} + \textbf{F10} key combination to toggle power to the module. The PC Camera module uses the \textbf{BisonCap} application to capture video files.

\begin{itemize}
\item \textbf{Taking Still Pictures}
\begin{itemize}
\item Double-click the \textit{My Computer} icon on the desktop, or go the \textit{Start} menu and point to \textit{My Computer}, then click it.
\item Double-click the camera icon. Click \textit{Take a new picture} in the \textit{Camera Tasks} box.
\end{itemize}
\end{itemize}

\begin{itemize}
\item \textbf{PC Camera Device and TV Module}
\begin{itemize}
\item If you have both an optional PC Camera and an optional TV Tuner module present, you will need to select which device to use with the \textbf{BisonCap} program. Go to the \textit{Devices} menu in the \textbf{BisonCap} program and select the \textbf{BisonCam, NB Pro} device.
\end{itemize}
\end{itemize}

\begin{itemize}
\item \textbf{PC Camera Display}
\begin{itemize}
\item The PC Camera application software needs to be run while the \textit{default notebook LCD} is the selected display device.
\item After a camera picture is obtained on the default notebook LCD, you may then use the \textbf{Fn} + \textbf{F7} to toggle through the display modes (give the screen time to refresh).
\end{itemize}
\end{itemize}
PC Camera Driver Installation

1. Make sure the module is powered on, and then insert the *Device Drivers & Utilities + User’s Manual* disc into the CD/DVD drive.
2. Click **Option Drivers** (button).
3. Click **1.Install WebCam Driver > Yes**.
4. Choose the language you prefer and click **Next > Next**.
5. Click **Finish** to restart the computer.
6. Run the **BisonCap** application program from the **BisonCam** shortcut on the desktop, or from the **BisonCam** item in the **Start > Programs/All Programs** menu (if the hardware is turned off use the **Fn + F10** key combination to turn it on again).

---

**Latest PC Camera Driver Information**

Check the disc, and any accompanying insert pages, for the latest updated information on the PC Camera driver, which may override the information provided here.

**PC Camera Display**

The PC Camera application software needs to be run while the **default notebook LCD** is the selected display device.

After a camera picture is obtained on the default notebook LCD, you may then use the **Fn + F7** to toggle through the display modes (give the screen time to refresh).
PC Camera Audio Setup

If you wish to capture video & audio with your camera, it is necessary to setup the audio recording options in Windows.

1. Go to the Start menu and point to Settings (or just click Control Panel) and click Control Panel, then double-click the Sounds & Audio Devices icon (Sounds, Speech, and Audio Devices in Category View).
2. Click Advanced in the Volume > Device volume tab.
3. Click Options and scroll down and click Properties.
4. Select Realtek HD Audio input from the Mixer device menu.
5. Make sure the Mic Volume (check box) is checked, then click OK.
6. Boost the volume in the Recording section (in the Recording Control menu) as high as it will go.
7. Close the Recording Control window, and then click OK.
8. Run the BisonCap application program from the Start > Programs/All Programs > BisonCam menu.
9. Go to the Devices menu heading and select Realtek HD Audio input (it should have a tick alongside it).
10. Go to the Capture menu heading and select Capture Audio (it should have a tick alongside it).
BisonCap

BisonCap is a video viewer for general purpose video viewing and testing, and capturing video files to .avi format.

1. Run the BisonCap application from the Start > Programs/All Programs > Bison-Cam menu (it is recommended that you set the capture file before the capture process - see Set Capture File below).
2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera Audio Setup” on page D - 36) and select Start Capture.
3. Click OK (the file location will be displayed in the pop-up box) to start capturing the video, and press Esc to stop the capture (you can view the file using the Windows Media Player).

Set Capture File

Prior to capturing video files you may select the Set Capture File... option in the File menu, and set the file name and location before capture (this will help avoid accidentally overwriting files). Set the name and location then click Open, then set the "Capture file size:" and click OK. You can then start the capture process as above.

Note the important information in “Reducing Video File Size” on page D - 38 in order to save file space, and help prevent system problems.
Windows XP Information

Reducing Video File Size
Note that capturing high resolution video files requires a substantial amount of disk space for each file. After recording video, check the video file size (right-click the file and select Properties) and the remaining free space on your hard disk (go to My Computer, right-click the hard disk, and select Properties) If necessary you can remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash drive.

Note that the Windows XP system requires a minimum of 1.5GB of free space on the C: drive system partition. In order to prevent system problems it is recommended that you save the captured video file to a location other than the C: drive (see “Set Capture File” on page D - 37), limit the file size of the captured video (see “Pre-Allocating File Space” on page D - 37) or reduce video resolution (see below).

To Reduce Video Resolution Output Size:
1. Run the BisonCap program.
2. Go to Options and scroll down to select Video Capture Pin....
3. Click the Output Size drop box and select a lower resolution size in order to reduce the captured file size.
Eliminating Screen Flicker

If you find that the video screen in the BisonCap program is flickering, you can try to adjust the setting in the Video Capture Filter options.

1. Run the BisonCap program.
2. Go to Options and scroll down to select Video Capture Filter....
3. Click either 50Hz or 60Hz under Frequency in Property Page (tab).

![Video Capture Filter](image)

*Figure D - 21
Video Capture Filter*
Windows XP Information

Zoom
The BisonCap program allows you to zoom the camera in and out.

1. Run the BisonCap program.
2. Go to Zoom and select Zoom Out/Zoom In.

Taking Still Pictures
The BisonCap program allows you to take still pictures.

1. Run the BisonCap program.
2. Go to Options/Capture and select Take Picture/Snapshot.
3. The picture (in JPEG format) will be placed in the Snapshot folder on the desktop.

Figure D - 22
Zoom/Setting

Snapshot Folder
The Snapshot folder’s default location is on the desktop. Do not move this folder or an error may appear when you try to take a still picture.

If you accidentally delete or move the folder, you can create a new Snapshot folder on the desktop in order to capture the files.
WLAN Module

Before installing the Wireless LAN driver use the **Fn + F11** key combination to toggle power to the module. Your installation procedure will be dependent upon which WLAN module is included in your purchase option.

**Download Prerequisite Files**

Before beginning the driver installation process for *Windows XP* it is necessary to make sure you have a working internet connection. You will then be pointed to download the required *Windows Installer 3.1* and Microsoft MSXML 6.0 files.
Windows XP Information

Intel WLAN Driver Installation
1. Make sure the module is powered on, then insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
2. Click Option Drivers (button).
3. Click 2.Install Wireless Lan Driver > Yes.
4. Click Next > Next to link to the required prerequisites on the internet.
5. Click Download (button) to download the Windows Installer executable (.exe) file to the computer’s hard disk.
6. Double-click the downloaded file (or click the Run button) to install Windows Installer and follow the on-screen instructions for file installation.
7. You will be required to restart the computer to complete the file installation.
8. Repeat steps 1 to 4 to get to the appropriate download location.
9. Click Download (button) to download the Microsoft MSXML file to the computer’s hard disk (if you are unsure of which file to download for your processor you can click Run instead of saving the file, and you will be informed if the file is appropriate or not).
10. Follow the on-screen instructions for file installation.
11. After the files have been installed click Next.
12. Click the button to accept the license and click Next > Next.
13. Click Finish to complete the installation.
14. Configure the settings by going to the Intel PROSet Wireless WiFi Connection Utility (Start > Programs/All Programs > Intel PROSet Wireless WiFi Connection Utility), or by double-clicking the taskbar icon.
15. Click to select any available network, and click Connect to establish a connection.
16. If you do not see your Wireless Access Point click **Refresh** (button).
17. Click **Help** (link) to bring up the **Help** Menu.
18. Make sure that the **WiFi On** button is selected.

*Figure D - 23 - Intel PROSet Wireless WiFi Connection Utility*
Fingerprint Reader Module

If you have included the fingerprint reader in your purchase option you will need to install the driver as per the instructions below.

Make sure you have administrator’s rights to your computer, and have a Windows password enabled for full security protection.

Before beginning the enrollment process it is recommended that you go through the fingerprint tutorial. To run the tutorial click Start > Programs/All Programs > Protector Suite QL > Fingerprint Tutorial after installing the driver.

Fingerprint Reader Driver Installation

1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
2. Click Option Drivers (button).
3. Click 3.Install FingerPrint Driver > Yes.
4. Click Software Installation.
5. Click Next > Next > Next.
6. Click Finish > Yes to restart the computer.
7. See overleaf for information on enrolling fingerprints etc.
User Enrollment

1. Click Start > Programs/All Programs > Protector Suite QL > User Enrollment, or double click the taskbar icon.
2. On the first run of the program you will be asked to click the button to accept the license, and then click OK.
3. Click Next and select “Enrollment to the hard disk”, and click Finish.
4. Click Next and you will then be prompted to enter your Windows password (note: If you have not set a password Protector Suite QL cannot secure access to your computer).
5. Click Next > Next (tick the “Run interactive tutorial” tickbox to run through the Fingerprint Tutorial).
6. Click Next for each window of the tutorial (you can click the button to “skip tutorial” at any time).
7. Click the button above any of the fingers to begin the enrollment process for that finger.
8. Swipe the finger three times to enroll that finger.
9. Repeat the process for all the fingers you wish to enroll (see below), and then click Next.

Figure D - 24 - Fingerprint Enrollment

Note that it is strongly recommended that you enroll more than one finger in case of injury etc.
10. Click Finish.
11. Click any of the headings under “Learn more about:” to get more information on any topic.
12. Click Close.
13. Right-click the taskbar icon to bring up the menu that allows you to Edit Fingerprints, start Control Center, access the Help menu etc. You can also run the Control Center etc. from the Protector Suite QL item in the Programs/All Programs menu.
15. If you swipe your finger over the reader at any time you can access the Biomenu to lock the computer, register websites, open the Control Center and access the Help menu.

Figure D - 25 - Control Center & Biomenu
USB TV Tuner Module

A CD containing drivers, software and a user guide will be supplied if your purchase configuration includes the **optional** USB TV Tuner module. In addition a driver is provided on the *Device Drivers & Utilities + User’s Manual* disc for the remote control supplied with the TV Tuner.

You will also be supplied with a remote control unit and appropriate antenna and fittings for the USB TV Tuner module.

The optional TV Tuner allows you to watch TV, play music CDs, video conference and capture still images and video on your PC.

The Cable (CATV) antenna jack will only be enabled when the TV Tuner module is installed. Make sure you install the driver before connecting the TV antenna.

---

**TV Antenna**

The TV antenna supplied with any TV Tuner module is intended for indoor use only. Please do not use your TV Tuner module outdoors.

**TV Tuner Remote**

Point the remote at the consumer IR transceiver to change channels etc.

---

**Figure D - 26**

**TV Tuner Ports/Jacks**

1. Infrared & Consumer Infrared Transceiver
2. Cable (CATV) Antenna Jack
Windows XP Information

Consumer Infrared Remote Control Unit Driver
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
2. Click Option Drivers (button).
3. Click 4.Install CIR Driver > Yes.
4. Click Next > Yes > Next.
5. Click Finish > Finish to restart the computer.

TV Tuner Driver Installation
1. Insert the MC770A Driver disc into the CD/DVD drive and double-click the device drive icon.
2. Click MC770A Driver V**** and S/W Encoder Setup.
3. Choose the language you prefer, and click Next > Next > Next > Next.
4. Click the button to accept the license agreement, and then click Next.
5. Click Next > Next.
6. Click “Yes, restart my computer now.” (button) and click Next.
7. Click Finish > Finish > Finish to restart the computer.
8. Insert the MC770A Driver disc into the CD/DVD drive and double-click the device drive icon.
9. Click AP Verr******** to install the application.
10. Click Next.
11. Click the button to accept the license agreement, and then click Next.
12. Click Next (make sure you input a User and Company Name).
13. Type in the serial number provided, and then click Next.
14. Choose the language you prefer, and click **Next**.
15. Click **Next > Next > Next**.
16. Click “**Yes, restart my computer now.**” (button) and click **Next**.
17. Click **Finish** to restart the computer.
18. Run the **Hybrid DTV** application from the **Start > Programs/All Programs > Hybrid DTV** and select the **Hybrid DTV** program or double-click the **Hybrid DTV** shortcut on the desktop.